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Preface 
This manual shows you how to use Avatar's MacMainFrame Series 
Workstation software on your Apple™ Macintosh computer. 

This book is for all MMF Workstations - Coax Workstations, Token-Ring 
Workstations, and SDLC Workstations. 

Audience 
This book is for people who use MacMainFrame Workstation machines. 

How To Use This Book 
If you've never used MacMainFrame Workstation before, follow the 
chapters in order. 

If you have used MacMainFrame Workstation before, tum to the section 
you need and follow the instructions there. 
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Related Documents 
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For More Help 

Contact Avatar Customer Support: 1-800-282-8276 
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Chapter 1 

Introduction to MacMainFrame 
Workstation 

The MacMainFrame Series Workstation hardware and software package lets 
your Macintosh computer connect to an IBM host computer. Once the 
connection is established, MacMainFrame Workstation emulates IBM 
3278/3279-style terminals on your Macintosh. Using the MacMainFrame 
Workstation, you can conduct several logical unit (LU) sessions at once 
with the host. (The number of LU sessions depends on your 
MacMainFrame Workstation machine and the availability of LU sessions at 
the host.) 

The following sections explain some of the things you'll need to know to 
use the MacMainFrame Series Workstation. 

Terminology: For convenience, we'll refer to any MacMainFrame Series 
Workstation (which includes Coax Workstations, Token-Ring 
Workstations, and SDLC Workstations) as a MMF Workstation hereafter. 
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Components 
Each MMF Workstation consists of the Workstation hardware and 
software. (Some Coax workstations have the option of an external 
hardware unit, called the DX Unit, which is a separate component.) 

• For Workstations that use internal boards, you install the board and 
the software onto your Macintosh. The MMF Workstation comes 
with complete software documentation. 

Since the board may not be an Avatar board, you may need additional 
documentation to install it and verify it before you can use the MMF 
Workstation software. 

Make sure you follow the vendor's documentation for your board, 
and make sure your MMF Workstation hardware and software are 
properly installed before you follow the instructions in the manual 
you 're reading now. 

• For Workstations that use an Avatar DX Unit, you may install the DX 
Unit locally or remotely. Software installation is the same as for 
Workstations that use internal boards .. 

For information on the DX Unit, see the MacMainFrame Series Coax 
Workstation Installation Guide. 

Connectivity 
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MMF Workstation offers three different types of connectivity to the IBM 
host: 

Coax 

Token-Ring 

SDLC 

Via a coax cable, which leads to a cluster 
controller that is connected to the IBM host. 

Via direct access to a token-ring LAN, which 
leads to the IBM host. 

Via an SDLC data communications line, which 
leads to the IBM host. 
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The diagram below shows three typical MMF Workstation setups: 

Cluster 
Controller 

Coax 
Workstation 

' 

IBM 
Mainframe 

~~~~~Token-Ring LAN 

Token-Ring 
Workstation 
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1-3 



Single-Session and Multi-Session Terminals 
IBM provides various kinds of access to its machines. The two kinds that 
concern us here are single-session terminals and multi-session terminals. 
Single-session means the terminal can use a single LU session at a time; 
multi-session means that the terminal can use more than one LU session at 
the same time. 

The MMF Coax DFT Workstation, the MMF Token-Ring Workstation, and 
the MMF SDLC Workstation all offer multi-session functionality. 

Coax Workstations 

In the case of Coax Workstations, the distinction between single- and 
multi-session terminals is important, as follows: 

• IBM terminals that can use only a single LU session at a time are 
called Control Unit Terminals - CUT for short. 

• IBM terminals that can use more than one LU session at a time are 
called Distributed Function Terminals - DFT for short. 

To obtain only single-session functionality on your MMF Coax 
Workstation, you order the CUT version of MMF Coax Workstation. To 
obtain both single-session and multi-session functionality, you 
order the DFT version. 

Differences Between CUT and OFT Workstations 
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Occasionally, the differences between Coax CUT Workstations and Coax 
DFT Workstations are important as far as setting up and operating your 
Workstation are concerned. In these cases, we have noted the differences in 
the text of this manual with two markers: 

CUT terminals only: 

Not for CUT terminals: 

I' CUT 

KCUT 
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If you see a marker, follow the marker. If you don't see a marker, you can 
assume the text applies to your MMF Workstation no matter what kind of a 
Workstation it is. 
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Operations 
The MMF Workstation requires some set-up and configuring. 

Set-Up Procedures 

To set up the MMF Workstation, you install the board into the Workstation 
machine, then install the software on the Workstation machine. (For 
Workstations that use the DX Unit, which is an external hardware unit, the 
hardware installation procedures are slightly different.) 

During first-time start-up, you configure the basic parameters of your 
Workstation, including initial LU session settings and the Workstation's 
address on the IBM network. After that, you need only alter your 
Workstation's settings as your IBM operating environment changes. 

Day-to-Day Operations 

After you've installed the MMF Workstation hardware and software and 
performed a first-time start-up, you invoke MMF Workstation as you would 
any Macintosh application. 

As it starts running, MMF Workstation automatically sets up the basic 
network connections with the IBM host and you can then use the host 
connections as you wish. 

Terminal Emulation, Screen and Keyboard Features 
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Once you have started the MMF Workstation software running on your 
Macintosh, you see a standard IBM 3270 screen, and your Macintosh 
keyboard behaves like a 3270-style keyboard. (Your Macintosh keyboard 
will function as a 3270 keyboard whenever you're in a 3270 window.) 
MMF Workstation also offers comfort features - scroll bars, font palette, 
LU indicator, and Keyboard Help button. 

The screen and keyboard are described in detail in Chapters 4 and 5. 
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If you are running under the MultiFinder, you can also step out of the 
Workstation's 3270 screen, perform Macintosh tasks or use other 
applications, and then return to the 3270 screen and resume 3270 work. 

Menus 

MMF Workstation has six pull-down menus: 

cut 
co1111 

[01111 Tab ·--~~~~~~~:: 
New!ie1 
Rema•e 
Sage 
Saue R1 Peale Re1et 5eui -·-··-·-·--·-··-·-·· 

--··-·-··--·· ··-·-··-·-··-·-"----- 1i unmled:I 
Page Se lelBt>t lereen NA 
Print Selec:tian... llP 
SaH Sahn:tion Rs ... 
Lo1 Fila ... 
Log Sohn:1 ion ta... KL 

UplOlld ... 
Dawn load ••. 
IM~ t~ !lost rnv. ... 
BB1Ch Fiie ••• 
Batch Tnnsrer ... 

Quit KQ 

unuueo:z 

K CUT 

Tod 

The menus let you manage your LU sessions, save data from the 3270 
window, transfer files to and from the host, and reconfigure your keyboard. 
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Dialog Boxes 
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The basic dialog boxes you'll use are shown below. (You don't need to 
read them here; they're fully documented throughout the book.) 

-llrlll••• 
a.-.-r1 I "'1d1IZ .. z• 
""I""'- C!J 

B"•..,lond"allrillolM 

....... _. .... mi .............. _rir-i -·-£:!! 1111,_. ..... 0 

C••-EWW 
llltlf'llllM. 

.. Mlld'M~ OCIDli ... IC.. D1SI 

..,._..,..._,.., •-· omc 

........... .._ .,,1a.c"'11"'n..._ ___ _. 

II I c:!:l 
C--·----

Cl:J Q! 
IM .. 

C...11• • !IZ"llfuno11an a1111,_ pahntl 

~ :::J •1:111:0 

.,... ................................................... '~~""'I .... ,~) (,, •• I 

......,... .. ,.... .......... ,... .... 
•rm o ..... o--•111111111111i'cl'ts 

trftllll~•n ..... lf!IZBI ....... ~ 
~n•••• ltt!Y.11 

""'Ill• llai:i:r1D 

n•-•• l!Ll ......... l!D 
H•lltllHI .. ,.. OUllJllll 

a .. , ... ,_ 
(1ml) (lttdlJ 
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And you can use the MultiFinder to step out to other applications and back 
into MMF Workstation again ... 

Saving Your MMF Workstation Session Settings 

MMF Workstation lets you save the way you set up your screen and 
keyboard for your LU sessions, as well as information about your IBM 
host environment, by recording the set-up in a Macintosh document. 

The documents, called Session Settings documents, let you start up 
quickly and easily and restore your Macintosh to the way you left it the last 
time you ran MMF Workstation. 

LU Sessions 

An LU session is the basic unit of connectivity to IBM hosts. LU (logical 
unit) and session are IBM network software terms that refer respectively to 
network nodes (like your MMF Workstation-equipped Macintosh) and 
ongoing network communication between a node and an IBM mainframe 
host. There are various types of LU sessions; the types are defined by the 
IBM host. 

Since the number of nodes with which an IBM host can communicate is 
limited, the host allocates LU sessions on a limited basis. 

Depending on the type of Workstation and the host, a single MMF Token­
Ring or MMF SDLC Workstation can get up to eight LU sessions. A MMF 
Coax DPT Workstation can get up to five LU sessions; a MMF Coax CUT 
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Workstation gets one LU session. (Other factors may limit the practical 
number of sessions per Workstation.) 

File Transfer 
You can transfer files to and from the IBM host using MMF Workstation's 
file transfer capability. The file transfer commands are selections in the 
Workstation's pull-down menus. You must be logged on to the host to 
transfer files, but you may transfer them in one LU session while you work 
in another, or you can transfer them in batch. 

For complete information on transferring files with MMF Workstation, see 
Chapters 6 through 11. 

3287 Printer Emulation 

K CUT MMF 3287 is not available on MMF CUT terminals. 

The MMF 3287 software, which comes with the MMF Workstation 
software, emulates an IBM 3287-style printer. MMF 3287 lets your 
Workstation machine receive an IBM print stream on one of its LU Sessions 
and route the print stream to its Chooser printer. (The printer can be directly 
attached to your Macintosh or it can be elsewhere on the local AppleTalk 
network.) 

For complete information on MMF 3287, see Chapter 12. 

MacMainFrame Graphics 

K CUT MMF Graphics is not available on MMF CUT terminals. 
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When you're running the MMF Workstation software on your Macintosh, 
you can also use the MMF Graphics software. MMF Graphics emulates 
IBM 3179G and 3192G color graphics terminals and lets users upload and 
download color graphics files into Macintosh-compatible files. 

For complete information on the MMF Graphics option, contact your Avatar 
representative. 
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Other Tools 
The MMF Workstation software offers a programming interface, called the 
API (Application Programming Interface), which complies with Avatar's 
MMF 3270 APL You can write programs in many languages to use this 
interface, including Pascal, C, and HyperTalk. 

For complete information on the MMF 3270 API, see the MacMainFrame 
3270 Series Application Program Inteiface Programmer's Guide, or contact 
your Avatar representative. 
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Chapter 2 

Start-Up and Shut-Down 

Introduction to Start-Up 
There are two ways to start the MMF Workstation software, first-time start­
up and everyday start-up. 

• If you've never started MMF Workstation before, do the first-time 
start-up. 

• If you have started MMF Workstation before and you have a Session 
Settings document, then you can do an everyday start-up. 

The first part of this chapter describes the two start-up methods and the last 
part describes shut-down. 

2-13 



2-14 

Before You Start 
Make sure the MMF Workstation software is installed: 

1. Pull down the Apple menu and select the Control Panel. 

2. In the Control Panel, select the Avatar icon. 

3. In the Avatar panel, make sure the correct MMF Workstation 
driver icon is already selected. Here, the MMF Token-Ring driver 
is selected: 

8bDU11t1B Finder ... 

fttHss P riuilvga1 
&lam Clod 
Cal culcrtor 
C:hDDSer 
rontrot Panel 
Find Fiie 
Key caps 
Strapbaak 

HDDU1 MUIUFinder ... 

rn 
~ 

General 

Ill 
iaiaira1 
Avatar 

Control Panel 

'"'" 6\fil Select connection m• I ~ Selected 

(See below for a list of possible driver icons.) 

If the correct driver icon is not selected, select it and then restart your 
Macintosh. (See your Workstation installation guide for complete 
information on installing your MMF Workstation.) 
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Selected Driver Icons 

The MMF Workstation driver icons look like this when they're selected: 

MMF COAX MMF Token- MMF SDLC 
Drivers: Rin_g_ Driver: Driver: 

II II Ill Ill 
ra=& ra9l::::s 

Mac SE CUT Mac SE DFT MMFTR MMF SDLC 

Iii II 
SE /30 CUT SE /30 DFT 

II II 
Mac llCUT Mac llDFT 

El 
DX CUT 
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First-Time Start-Up 
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Make sure you've installed the MMF Workstation software. See the 
installation guide for your Workstation. (The MacMainFrame Series Coax 
Workstation Installation Guide,Token-Ring Workstation Installation Guide, 
or SDLC Workstation Installation Guide.) 

The first time you start MMF Workstation, you must start it from the 
application icon. The icons are slightly different for each: 

Token-Ring, SDLC: 

m1:i1:ia 
1!11!11!11!1 

MacMainFrame 
Workstation 

Coax DFT: 

ffi orT 
mm mm 

MacMainFrame 
Workstation 

Coax CUT: 

~~ ==-= =':'= 
liJ CUT 

MacMainFrame 
Workstation 

Later you can start it from a Session Settings document. 

At first-time start-up, MMF Workstation will ask you to supply some 
information about yourself and your terminal (that is, about your 
Macintosh) and to pick an LU session. 

When you finish using MMF Workstation after this first-time start-up, you 
can save the information you supplied plus all the settings- color, position 
of 3270 windows, number of LU s, and so on - in a Session Settings 
document. Later, you can use that document to re-start MMF Workstation. 

The following steps describe how to perform first-time start-up. 
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1. Open the MMF Workstation application. 

Start the software by double-clicking on the MMF Workstation icon. (We'll 
use the Token-Ring and SDLC Workstation icon to stand for all 
Workstations from now on.) 

t:lt:lt:lt:l 
t:lt:lt:lt:l 

Mac Mainframe Workstation 

The software will present you with a personalize box. 

2. Fill out the Personalize box. 

This personalizes your copy of the MMF Workstation software: 

if Please personalize your copy of wl MacMoinFrome: 

Name: 

Organization: 
'--~~~~~~~~~~ 

OK Cnncel ) 
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After you click OK, you'll see the menu bar change from the Finder's: 

,.. s File Edit Uiew Speciol Color 

to MMF Workstation's: 

r 9 File Edit Settings Windows Function Keys Easy Keys II .., 

~ 
K CUT 
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3. Open a Session Settings document. 

Pull down the File menu and select New: 

K CUT 

OJHHI ... 
Close 

---1[ NmH S•~s~ion.,, :•:N 
H<m1m1<~ S•~s~ion ,,. 

This will cause MMF Workstation to start recording a new set of session 
settings. It will also start the first LU session for you, and to do so it will 
first present you with the Session Settings dialog box. 

Session Settings Dialog Box 
The Session Settings dialog box contains different items depending on your 
Macintosh and how the MMF Workstation(s) are configured. 

If this is the first time you've run MMF Workstation, we suggest you just 
leave the box as is and click OK. (Naturally, if your network administrator 
has a specific LU he or she would like you to use, use that.) Later, you can 
go back and reset the parameters you want by pulling down the Settings 
menu and selecting Session ... , which will give you the Session Settings 
box again. 
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Here's a sample Session Settings dialog box: 

K CUT ----1[ 

Session Settings 

Screen size I Model 2 - 24H80 

Logical Unit [[] 

181 Use eHtended attributes 

Screen font size [!!] Print font size II] 
Print font ._I _11._rr._m_o._.,,k ____ _ 

Cursor style O Underline @ Block 

D Use Host Cursor 181 Blinking 

Background @ I 'Whit• I 0 ------Iv.now I 
( Default Colors ) 

•1--o·K--..D ( Cancel 

For complete information on how to fill out the Session Settings box, see 
the Session Settings section at the end of this chapter. 

After you click OK in the Session Settings box, MMF Workstation will 
automatically establish connection to your IBM host. 

You'll see the initial host screen, and you can then log on to the IBM host. 
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~ 
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Fii I In your USER ID and PASSUDRD and preee EHTER 
(YC1.Jr passuard ul II not app~ar uh!n you typ~ It) 

USER ID --->I 
PA9SUOAD ···> 
C:DmRND ---> 

RUHHI NG 11nRURTRR 
si( 0 

Wti l<.'ll JOI~ Qi 

(This screen is from one of Avatar's IBM machines; yours will surely look 
different.) 
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Irregular Start-Up 

Occasionally, there are delays and you11 usually see status messages about them: 

With Coax Workstations: Delays may be due to problems on the host or the 
cluster controller. 

With Token-Ring Workstations: If the Token-Ring is busy, there may be a 
delay while your Workstation comes up. 

After your 3270 windows appear, you may see one or more of the following 
message numbers on the 3270 windows' status lines: 

--z.... 501 J 505 J 510 J 520 

These numbers refer to conditions on the networking and communications layer of 
the software. 

• If the message number persists for one minute, check the settings in the 802.5 
Setup panel in the Avatar Control Panel to make sure they're correct. 

• If the Control Panel settings are correct and you still can't reach the IBM host, 
see your network administrator. 

With SDLC Workstations: These message numbers may appear on the 
status lines of your 3270 windows: 

--z.....501, 505, 510, 520 

These numbers may indicate that modems are not functioning properly or that there 
are problems on the intervening SDLC link(s). 

• If the message number persists for one minute, check the settings in the SDLC 
Setup panel in the Avatar Control Panel to make sure they're correct. 

• If the Control Panel settings are correct and you still can't reach the IBM host, 
see your network administrator. 

If delays persist, see your network administrator. 
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4. Use MMF Workstation. 

You're ready to start working. 

For more information on how to change MMF Workstation's Session 
Settings, see Chapter 3. 

For detailed information on using MMF Workstation's screen and 
keyboard, see Chapters 4 and 5. 

For information on how to transfer files with MMF Workstation, see 
Chapters 6 through 11. 

For information on how to use the MMF 3287 Printer Emulator software, 
see Chapter 12. 

5. Shut Down. 

When you're finished working with MMF Workstation, pull down the File 
menu and select either CI o s e or Quit. 

Make sure to save your MMF Workstation settings. Either 

• Select S 8 u e or S 8 u e Rs •.• from the File menu before you shut 
down, or 

• Answer Yes when MMF Workstation asks you if you want to save 
them as you shut down. 

If you don't do this, you will lose the Session Settings document that MMF 
Workstation created for you (at the beginning of this invocation of MMF 
Workstation), and you will have to do a first-time start-up again. 

For complete information on shut-down, see the "Shut-Down" section at the 
end of this chapter. 
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Everyday Start-Up 
When you do an everyday start-up ofMMF Workstation you just double­
click on a Session Settings document. The Session Settings document 
icons are slightly different for each workstation: 

Token-Ring, SDLC: Coax DFT: Coax CUT: 

~ . ~ . 
Untitled Untitled Untitled 

The following steps explain how to start MMF Workstation from a Session 
Settings document. 

1. Go to the Session Settings document. 

Choose the Session Settings document that contains the settings you want. 

2. Double-click on the document's icon. 
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Here, we double-clicked on TSO-sessions. (Again,we're using the icons 
for Token-Ring and SDLC Workstations to stand for all Workstations.) 

c1cL.ln• ~ 
Sessions- 8.22.14 
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MMF Workstation will start running, first displaying your personalize box: 

,., This copy of MocMoinFrome 
is personalized for: 

Nome: Jon Burrowes 
Orgonizotion: Ruotor Marketing 

Then you 11 see the menu bar change from the Finder's: 

,.. s File Edit Uiew Special Color 

to MMF Workstation's: 

,..~ v, 
w File Edit Settings Windows Function Keys Eosy Keys ~ 

~ 
>t CUT 

MMF Workstation will automatically open 3270 windows for your LU 
sessions. It will place them where they were on the screen when you last 
used this document. 
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Irregular Start-Up 

Occasionally, there are delays and you'll usually see status messages about them: 

With Coax Workstations: Delays may be due to problems on the host or the 
cluster controller. 

With Token-Ring Workstations: If the Token-Ring is busy, there may be a 
delay while your Workstation comes up. 

After your 3270 windows appear, you may see one or more of the following 
message numbers on the 3270 windows' status lines: 

~ 5011 5051 5101 520 

These numbers refer to conditions on the networking and communications layer of 
the software. 

• If the message number persists for one minute, check the settings in the 802.5 
Setup panel in the Avatar Control Panel to make sure they're correct. 

• If the Control Panel settings are correct and you still can't reach the IBM host, 
see your network administrator. 

With SDLC Workstations: These message numbers may appear on the 
status lines of your 3270 windows: 

~ 5011 5051 5101 520 

These numbers may indicate that modems are not functioning properly or that there 
are problems on the intervening SDLC link(s). 

• If the message number persists for one minute, check the settings in the SDLC 
Setup panel in the Avatar Control Panel to make sure they're correct. 

• If the Control Panel settings are correct and you still can't reach the IBM host, 
see your network administrator. 

If delays persist, see your network administrator. 
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3. Use MMF Workstation. 

Use MMF Workstation. Chapters 3 through 11 describe how to use all 
MMF Workstation's features. 

JC CUT To get a new LU session, pull down the File menu and select New 
Session .••. 

MMF Workstation will start a new LU session for you (providing one is 
available) by presenting you with the Session Settings dialog box, which is 
described in the next section. After you fill out the dialog box, you'll see 
the initial host screen, and you can then log on to the IBM host. 

m-- Untitled 
UIRTUAL nRCHIHE/S~STEn PRODUCT 

RRRR 
AA AA 
RR RR 
RARRRR 
RR RR 
RR RR 

11n un11s s.1 •t 
RURTRR CDRPDRRTIDH 

(LEUEL BBB&) 

uu uu 
uu uu 
uu uu 
uu uu 
uwu 
uu 

RRRR TTTTTT RRAR 
AA AA TT AA AR 
AR RR TT RR RR 
ARRRRR TT ARRRRR 
AR RR TT AR RR 
AR RR TT AR RR 

Fl 11 In your USER ID and PRSSUDRD ind pra .. EHTER 
{V11.1r p•ssuard ulll nal •pp••r uhen yau typ• It) 

USEJllD --->I 
PRBSUORD •••> 

CDmRND •••> 

RRRRR 
AA AA 
RR RR 
RRRR 
RR RR 
RR RR 

RUHHING YRRURTRR 

(This initial screen is from one of Avatar's IBM machines; yours will surely 
look different.) 

You can get as many new LU sessions as there are sessions available; when 
there are no more LU sessions, New Session ••• will be grayed out. 
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4. Shut-Down. 
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When you're finished working with MMF Workstation, pull down the File 
menu and select either CI o s e or Quit. 

For complete information on shut-down, see the "Shut-Down" section at the 
end of this chapter. 
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The Session Settings Dialog Box 
The Session Settings dialog box lets you tell MMF Workstation how to set 
up your screen and keyboard and what kind of LU sessions to use.The 
contents of the Session Settings box will change depending on the kind of 
Macintosh you have and the LU sessions you select. 

It will also change if you're using the MacMainFrame Graphics software. 
For information on MacMainFrame Graphics, see your Avatar 
representative. 

Here are the boxes for Macintoshes with monochrome and color monitors, 
respectively: 

Session Settings 

Screen size I Model 2 - 24H80 

Loglcnl Unit II] 

·--·--·-----
Screen font size [JI] Print font size II] 
Print font I Hrmonk I 
Cursor style O Underllne ® Block 
D Use Host Cursor 181 Blinking 

B11ckground ® I 'tihtl• O HMM 

I OK ) Cancel 

For monochrome monitors 

Session Settings 

Screen size I Model 2 - 24H80 

Loglcnl Unit [[] 

181 ll'e e11tendM attributes 

Screen font size [JI] Print font size II] 
Print font l....._er._m_o._wk ___ __. 

Cursor style O Underline ® Block 

D Use Host Cursor 181 Blinking 

+;+ 

I OK , Cencel 

For color monitors 

)t CUT (Since MMF CUT Workstations provide only one session, the Logical unit 
pop-up menus do not appear in MMF CUT Session Settings dialog boxes.) 
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Session Settings Box: Pop-Up Menus 
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The five items with shaded boxes- Screen size, Logical Unit, 
Screen font size, Print font, and Print font size -have 
pop-up menus. 

To get these menus, click the mouse on the item, and then while holding the 
mouse down, scroll up or down the resulting menu and release on the 
selection you want. 

To select nothing, slide the mouse off the menu before releasing or leave the 
item as is. 

7 
9 
10 

Sc re en font size 12 

Si:reen size Model 2 - 24H80 
13 
14 
18 

I 
K CUT 

2 
3 
4 

Model 3 - 32H80 
Model 4 - 43H80 
Model 5 - 27H132 

Print font R'moni: 
Chicago 
Courier 
Geneua 
Heluetica 
Monaco 
New Y11rk 
Times 
Uenice 
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Session Settings Dialog Box: Items 

The following sections describe how to fill out the items in the Session 
Settings dialog box. If you skip an item, MMF Workstation will use the 
default value that appears in the item's field. 

Screen size 

Select the screen size that the host will use when it sends and receives data 
on your LU sessions. For more information on these screen sizes, see the 
host system manager. 

Logicol Unit 

JC CUT This item is not available on MMF CUT Workstations. 

Scroll through and release on a logical unit (LU). 

When an LU name is grayed, it means that LU session is currently 
unavailable. 

REMEMBER: See your host system manager or network administrator for 
up-to-date information about the kinds of LU sessions that are available 
from the host. 

D Use eHtended ottributes 

Specify here whether or not the LU session will transmit and display the 
following kinds of data: 

D Do not display any graphics or extended attributes. (This is the 
default.) 

t8l Display extended attributes when they arrive at the Workstation. 

(Extended attributes are sometimes referred to as EABs. EAB stands for 
Extended Attribute Buffer. Examples of extended attributes are: 
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underlining, blinking, reverse video, and three additional colors. For more 
information on EABs, see Chapter 3.) 

REMEMBER: You should specify the LU session the same way the host 
configures it. 

Screen font size 

The size that will appear in your 3270 window. The font sizes are: 7-, 8-, 
9-, 10-, 12-, 13-, 14-, and 18-point type. (The screen font is Armonk™, 
Avatar's proprietary font for MMF applications.) 

Default: 12 point for large Macintosh monitors, 9 point for small Macintosh 
monitors. 

Print font size 

The size of the font that will appear on your printer when you print your 
screen. 

For Armonk font, the sizes are: 7-, 8-, 9-, 10-, 12-, 13-, 14-, 18-, and 24-
point type. (To see the sizes for the other fonts, click on the Print Font 
field to pop-up the font menu, scroll down the menu and select a font, then 
click on the screen font size field to pop up the font sizes menu.) 

Print font 

The font that will appear on your local printer when you print your screen. 
The font choices are Armonk and whatever fonts you have in your System. 
Use the Font/DA Mover to change the fonts in your System. 

Cursor style 
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Pick the cursor style you're comfortable with, either Underline/Block or 
Blinking. 
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If you select Use Host Cu rs or, the host will control the cursor's 
appearance. Use Host Cu rs or overrides the other cursor selections. 
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Color 

If your Macintosh monitor supports color, the Session Settings box will 
show four color blocks and a highlight-color block. 

If the LU session you pick supports extended attributes (EABs, explained in 
Chapter 3), you'll see eight color boxes. 

Here's an example of a Session Settings dialog box with all the color items: 

K CUT ---;: 

Session Settings 

Screen size I Model 2 - 24H80 

Loglcel Unit l:J:J 
181 UH eHtended attributes 

Screen font size [![) Print font size ITI 
Print font I Hrmonk I 
Cunor style O Underline ® Block 
D Use Hoit Cursor 181 Blinking 

I OK Cencel ) 

The color blocks themselves will change depending on the kind of color 
support the IBM LU session offers. (Extra colors are one of the extended 
attributes that characters can have.) 

The following sections describe the color items. 

Background 
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Select the background color the screen will have. (The other colors change, 
too, when you select a different background color.) 

NOTE: The background color doesn't have to be literally black or white­
you can set the hue to suit yourself. Double-click on either color block and 
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Color 

then use the resulting color wheel to set the background color the way you 
want. 

The color blocks show how MMF Workstation displays IBM colors. 

There is a black block and a white block for the background colors. 

For the remaining colors, the Session Settings box displays color blocks 
according to the LU session. (This, in tum, depends on what the IBM host 
offers. For example, LU sessions that don't support extended attributes 
will show only 4 color blocks.) 

Default colors 

Oick on this button to have MMF Workstation restore the IBM colors to 
your 3270 window. 

This button is useful if you've modified the colors (see below) and want to 
change them back to the host's default colors. 
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Changing Colors 
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You can change the way the IBM colors appear in your 3270 window, and 
you can do so on a per-session basis. (And MMF Workstation will save a 
separate set of colors for each LU session.) 

1. Go to the Session Settings box. 

2. Double click on any color block in the Session Settings box. 

MMF Workstation will then present you with the color wheel: 

1.3 

Choose new Turquoise 

D 
Hue 10457 (;) 

Saturation 64539 (;) 
Brightness 65535 (#) 

Red 65535 (;) 
Green 62784 (;) 

u D (Cancel ) 
Blue 997 (iJ OK 

3. When the color wheel appears, set the color as you wish. (The color 
wheel works the same way as the Macintosh Control Panel color 
device. For complete information, see your Macintosh system 
documentation.) 

When you're done, click OK. 

When you return to your 3270 window, the items that take their color from 
the color block you double-clicked will now have the new color. 
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Saving Your Settings 

Don't forget to save the changes you've made in the Session Settings box. 
To save your settings, select Soue or Soue As ... from the File pull­
down menu. 

For complete information on saving your settings, see the "Shut Down" 
section below. 
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Shut-Down 
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When you're finished using your current LU sessions, you can either 
release your LU sessions and leave MMF Workstation running, or you can 
stop MMF Workstation running, which automatically releases your LU 
sessions. 

Most importantly you should save your settings. This saves you work the 
next time you start-up and it allows you to tune your MMF Workstation set­
up over several sessions to be the way you want it. 

The following sections tell you how to save your settings and then perform 
the various shut-downs. A couple of reminders: 

REMEMBER: Closing windows (by clicking in the close box) does not 
release sessions or stop MMF Workstation. 

GOOD PRACTICE: 

DONT FORGET TO LOG OFF THE IBM HOST 
FIRST! 
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Saving Your Settings 

As we've mentioned, saving your settings can save you work the next time 
you start MMF Workstation. 

To save your Session Settings, either: 

• Select Soue or Soue Hs ... from the File pull-down menu while 
you're still running MMF Workstation: 

K CUT ----1[ New Sessior 
Jlcm1m1c~ S•~s 

Salle 
Saue Rs ... 

Page Setup. 
Sldnf <.•~h>1•fi 

Nt~UJ :•:N 
Oi1<m ... :•:O 
C:lose XW 
New Session... XN 
H<~rnm10 S•~s~ion ... 
Saue XS 

Page Setup ... 
Sldnf <.1.\h\1•flon 

• Or, after you select Quit or CI o s e from the MMF Workstation File 
menu, click on Yes in the following dialog box: 

Saue Settings 1 before quitting? 

(( Yes )J 
(----N-o-~ Cancel 

(If this is for a new document, you'll have to supply a filename.) 
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MMF Workstation saves your settings in a Session Settings document, 
whose icon looks like this, depending on your Workstation: 

Token-Ring, SDLC: 

~ 
~ 

Coax DFT: Coax CUT: 

l::il 
LI 

The Lock Box 
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The Lock check-box in the Saue As ••• dialog box prevents you from 
making any further changes to the Session Settings document or saving it 
again. 

Saue terminal file as: 

Cancel 

D Lock file 

To unlock a locked Sessions Settings document, you must go to the Finder, 
pull down the File menu, and select Get Info. Then click the Locked box 
to unlocked: 

D 

~ 
~ 

Info 

settings 1 
Locked D 

Avatar IBM 3270 Emulation 
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What Is A Session Settings Document? 

A Session Settings document is a record of the way you set up your MMF 
Workstation program. It lets you start running again the way you were 
running when you shut down: this includes the positions of the 3270 
windows you were using, the colors you were using, and so on. 

A Session Settings document also lets MMF Workstation keep track of the 
LU session(s) that you used; so you can get the same LU sessions each time 
you use the document. (If you had four LU sessions running the last time 
you used this document, you'll still see four 3270 windows, but there will 
be only two with LU sessions running; the other two windows will have 
messages on their 3270 status lines. (Exceptions: On Coax DFf 
Workstations you'll see only see two windows; and Coax CUT 
Workstations are single-session.) You can still go to work in the two LU 
sessions you do get.) 

And finally the Session Settings document is a quick and easy way to start 
the MMF Workstation application running 

Contents of Session Settings Documents 
The Session Settings document includes: 

• Number and screen position of your 3270 windows. 

• Configurations of your keyboard and function key palette. 

• Easy Keys you created. 

• LU sessions you used. 

• Colors, on a per-LU-session basis. 

• Information about the IBM host environment (e.g., CICS, VM/CMS, 
TSO) that you supplied. 

• Screen log and batch file names. 

And other information. While you're working, MMF Workstation saves 
this information in a temporary file; to save it permanently, see the "Saving 
Your Settings" section above. 
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To Release One LU Session But Not Shut Down 

K CUT This feature is not available on MMF CUT Workstations. 

1. Go to the LU session's 3270 window. 

2. Select Remoue Session ... from the File menu. You'll see the 
following dialog box: 

3. Click OK. 

Do you wont to permanently remoue 
Session 2? 

( OK J 

n Cancel D 

MMF Workstation will now terminate the LU session and release it to the 
host. It will also remove the session settings from your current Session 
Settings document. 

MMF Workstation remains running. 

To Release All LU Sessions But Not Shut Down 
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Close the current Session Settings document by selecting Close from the 
File menu. 

This terminates all your current LU sessions and releases them to the host. 
It also leaves MMF Workstation running, so you can open another existing 
Session Settings document, create a new Session Settings document, or go 
to another application for a while and return. 
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To Release All LU Sessions and Shut Down 

Select Quit from the File menu. 

This terminates all your current LU sessions and releases them to the host. 
It also shuts down MMF Workstation. 

lh:>h:> h:> H1>st f"ih:> .,, 
BBtch File ... 
BBtch Tronsfer ... 

Quit :~:Q 

REMEMBER: If you've made any modifications to your session settings 
while you were working, MMF Workstation asks you if you want them 
saved permanently: 

S8ue Sess1 before quitting? 

(( Yes )J 

( No ) Cancel 

Answer as you wish. If you don't want to save them under the same file 
name, click Cancel, then pull down the File menu and select Saue ns ... 
to save them under another name. 
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Chapter 3 

Operating MacMainFrame 
Workstation 

Introduction 
Most of your time with MMF Workstation will be spent using your 
Macintosh like a 3270-style terminal. This chapter mentions these basic 
operations, which are described in more detail in their respective chapters. 

While you're working, you can change the way MMF Workstation 
behaves. This chapter focuses on: 

• How to manage your LU sessions - how to open them, switch from 
one session to another, and close them, and 

• How to make changes to your Session Settings document. 

For information on transferring files with MMF Workstation, see Chapters 
6 through 11. 

Basic Operations 
The basic operations you'll perform with MMF Workstation are: using the 
screen and keyboard, moving back and forth between MMF Workstation 
and other applications, and transferring files. 

Using Your Screen And Keyboard 

When you're in a MMF Workstation 3270 window, you can use the 
window and your Macintosh keyboard together the way you would use a 
3270-style terminal. 
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For complete information on MMF Workstation's screen and keyboard 
features, see Chapters 4 and 5. 

Using Other Macintosh Windows 

You can leave the MMF Workstation application entirely, go to other 
windows and do other work, and then return to your MMF Workstation 
3270 windows. You can leave your LU sessions idle as long as you wish 
until you shut down MMF Workstation; MMF Workstation will not release 
them to the host. 

NOTE: You must be running the MultiFinder on your Macintosh to use this 
feature. 

File Transfers 

To transfer files between your Macintosh and an IBM host with MMF 
Workstation, follow these steps: 

• Specify the host environment characteristics by pulling down the 
Settings menu, selecting Host ... , and filling out the resulting box. 

• Pull down the File menu, select Upload or Download, and fill 
out the resulting dialog box. 

For complete information on file transfer, see Chapters 6 through 11. 

Printer Emulation 

K CUT This feature is not available on MMF CUT Workstations. 
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You can use your MMF Workstation-equipped Macintosh to emulate an 
IBM 3287-style printer. To do this, you use MMF 3287. For information 
on using MMF 3287 on your MMF Workstation machine, see Chapter 12. 
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How to View LU Sessions 

)C CUT This feature is not available on MMF CUT Workstations. 

To see a list of the LU session windows that your MMF Workstation is 
currently using, pull down the Windows menu. The bottom panel shows 
the current sessions. 

Here, two LU sessions are running, Untitled: 1 and Untitled:2: 

lllindoll•s 
Hide session XH 
Jump Session XJ 
Stack Windows 
Tile Windows 

t:.. Untitled:l X1 
Untitled:2 X2 

The triangle beside session Untitled: I means Untitled: l's 3270 window is 
hidden from view. To bring it into view again, select Untitled: I here. 

To find out whether the sessions are running or not, go to each session's 
3270 window and view the messages on the 3270 status line. 

Extended Attributes (EAB) 

EAB stands for Extended Attribute Buffet,". An EAB is a mechanism by 
which IBM machines store and transmit character data. 

Normally, each character on an IBM display screen has an attribute byte 
associated with it. Attribute bytes (which are part of the main character 
buffer) specify basic information about their characters; attributes include 
the character's protection and four basic colors. Extended attribute bytes 
(which are part of an extended buffer) specify additional attributes; extended 
attributes include blinking, reverse video, underlining, and three additional 
colors. 
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How to Get an LU Session 
This section explains the various ways to get LU sessions. 

To Start The First LU Session 

X CUT 
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If you haven't opened a Session Settings document yet, pull down the File 
menu and select New or Open: 

Both selections will start recording Session Settings; 0 pen will ask you 
for the name of an existing Session Settings document, and New will start 
a new Session Settings document and send you to the Session Settings 
dialog box. 

If you have opened a Session Settings document already: 

• MMF Workstation will open any existing LU session window(s) 
automatically (except for the hidden windows). 

• To open the hidden windows, pull down the Windows menu and 
select the windows with triangles next to their names. 

• To get LU sessions in addition to the sessions in the above windows, 
select New Session ... in the File menu. (If there are no more LU 
sessions available at the host or because you've reached the sessions-
per-Workstation limit, New Session ... will be grayed out in the 
File menu.) 

(The New Session ... feature is not available on MMF CUT 
Workstations.) 
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To Start The Next LU Session 

K CUT This feature is not available on MMF CUT Workstations. 

To get an additional LU session, select New Session ... from the File 
menu. 

New ~N 

DJH-Hl,,. :•:O 
Close 3€W 
New Sessic1n... :~:N 

lh~mo1H~ S<~~sion .. , 
Soue 3€5 
Soue Rs •.• 

New Session ... sends you to the Session Settings box. Fill out the 
box, and MMF Workstation will then start your LU session. 

If there are no more LU sessions available at the host or because you've 
reached the sessions-per-Workstation limit, New Session ... will be 
grayed out in the File menu. 

To Switch LU Sessions 

K CUT This feature is not available on MMF CUT Workstations. 

There are several ways to change from one ongoing LU session to another: 

• Click on the window of that session. 

Operating MMF Workstation 3-49 



• Pull down the Windows menu and select the LU session you want: 

TSOsess:l 
TSOsess:2 

XI 
X2 

} Select 8 session 

• Pull down the Windows menu and select Jump Session; this 
rotates through the windows in order. 

Stack Windows 
Tile Windows 

• Go directly to window 1 by pressing X-1 , to window 2 by pressing 
X-2, and so on. 

How Many LU Sessions Can I Get? 
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The number of LU sessions you can use depends on 

• How many LU sessions are available from the host. 

• How many LU sessions the MMF Workstation allows: 

MMF Coax CUT Workstations 1 LU session 

MMF Coax DFT Workstations 

MMF Token-Ring Workstations 

MMF SDLC Workstations 

Up to 5 LU sessions 

Up to 8 LU sessions 

Up to 8 LU sessions 

To get the maximum number of LU sessions, pull down the File menu and 
select New Session ••• until New Session ..• appears grayed out. 
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How To End LU Sessions 
Generally, you'll end your LU sessions at the same time you shut down 
MMF Workstation. For information on ending your LU sessions then, see 
the Shut-Down section in Chapter 2. 

This section describes other ways that LU sessions can end. 

To End A Single LU Session 

K CUT This feature is not available on MMF CUT Workstations. 

Ending a single LU session isn't a very frequent occurrence, but if you need 
to do it, here's how: 

1. Go to that that session's window. 

2. Log off the IBM host. 

3. Select Remoue Session from the File menu. 

Saue Rs •.. 

This terminates the LU session, and it also removes it from your Setting 
Sessions document. 

REMEMBER: Closing a 3270 window by clicking on the close box or 
leaving a 3270 window does not terminate an LU session. It just hides the 
window. 
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How To Change Your Session Settings 
This section assumes you've gone through first-time start-up at least once 
and that you have at least one Session Settings document. See Chapter 2 
for complete information on First-time start-up. 

The Session Settings document's main purpose is to save your set-up of 
MMF Workstation so you can start it again quickly and easily. You can 
change these settings by using any of the selections in the Settings menu -
they give you access not only to the Session Settings dialog box but to the 
parameters concerning the host environment, the keyboard, and your 
Easy Keys. 

All these items are stored in the Session Settings document. 

To Change The Open Session Settings Document 
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To make changes to the Sessions Settings document that's currently open: 

1. Select Session ... from the Settings pull-down menu: 

Function Keys ... 

Reset Session 

Session ... will give you the Session Settings box again. 

2. Fill out the Session Settings box as you normally would.(Remember, 
you can also change the host environment settings, your keyboard 
configuration, and your Easy Keys.) 

After you click OK in the dialog box you've selected, the new settings 
you've made go into effect in your current LU session. 

To keep these new settings so you can use them the next time you start 
MMF Workstation, either select Sau e or Sau e Rs ... from the File menu, 
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or answer yes after you quit when MMF Workstation asks you if you want 
to save them. 

To Change An Unopened Session Settings Document 

To make changes to a Session Settings document that's not open: 

1. Make sure you're in the MMF Workstation application. 

Make sure you have an active MMF connection to the IBM host. (It's 
not necessary to be able to log on to the IBM host, though.) 

2. Select 0 pen from the File menu and supply the name of the Session 
Settings document you want to change. 

MMF Workstation will open the document and set up your screen and 
keyboard as in normal operation. 

3. You can now make changes to this open Session Settings document 
- use the Session Settings box, Host settings box, keyboard 
windows, etc. 

4. When you're finished making changes, select Saue or Saue As ... 
from the File menu to preserve the changes, then select CI o s e from 
the File menu to close the document. 
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Chapter 4 

The 3270 Window 

Introduction 
MMF Workstation's 3270 window fully emulates a 3278/3279 terminal 
screen You'll see the status line at the bottom, and as you work, the 3270 
symbols will appear there. You can use the 3270 window the same way 
you would use an IBM terminal screen. 

In addition to 3270 screen emulation, the MMF Workstation 3270 window 
offers: 

• Standard Macintosh features such as sizing boxes, zoom boxes, and 
scroll bars. 

• A font size palette, which lets you quickly change the font size on 
your screen. Useful when you're emulating a 132-character-per-line 
or 44-line-screen terminals. 

• An LU indicator, which shows your current logical unit (LU) number. 

• A keyboard HELP button, which lets you find function keys quickly 
on your Macintosh keyboard. 

• Rearranging multiple windows into a neat side-by-side or overlapping 
display. 

You can have up to eight 3270 windows open at once (depending on your 
Workstation and the availability of LU sessions from the IBM host.) 
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Elements of the 3270 Window 

4-56 

13 
14 

2) MflCMflinFrBme 
title bar 

4) Font size pBlette ---- ll> 
1) Close box 

8) IBM status line 

5) Scroll bars~ 

6) Sizing box 

-1----

(1) Close box - Hides the LU session in this window but does not 
terminate the session. 

(2) MMF title bar - Works the same as a regular Macintosh window title 
bar. Click to select the window or move the window; use the sizing boxes 
in the right-hand corners to size the window. 

REMEMBER: Closing the window hides the window but does not 
terminate the LU session. To see hidden windows, pull down the 
Windows menu; the hidden windows have triangles next to them. 

(3) Zoom box - Works the same as a regular Macintosh zoom box. 

(4) Font Size Palette- Selects the font size in which data will appear in 
your 3270 window. 
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The initial font size comes from the Screen Font Size item in the 
Session Settings dialog box. 

NOTE: MMF never saves setting changes you make here; it saves only the 
setting changes you make to the Screen Font Size item in the Session 
Settings dialog box. 

(5) Scroll bars - Work the same as regular Macintosh scroll bars 

(6) Sizing box-Works the same as a regular Macintosh sizing box. 

(7) Keyboard Help Button - (Click the question mark:) 

Displays a box that shows the positions of the IBM 3270 keys on your 
keyboard. (You can use this box to type keys -just click the mouse once 
on the desired key. For more information on function keys, see Chapter 5.) 

(8) IBM status line - Displays information from the IBM host about 
your LU session. (MMF Workstation keeps the status line visible 
regardless of how you size the window.) 

(9) LU indicator- Displays the logical unit (LU) number that this 3270 
window's host session is using. 
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Using the 3270 Window 
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Use the 3270 window just like you would use a normal 3270-style terminal 
screen. Type commands, press ENTER to send them to the host, and so 
on. 

U I RTlRL tlR~I ~/G\lli:TEI PRCDU llT 

AAAR 
All llA 
FIR RA 
AA RA RA 
fUI ftA 
AA RA 

1an un11:1 :i. i 1t 
RURTIR ECRPDRRTllJ'I 

(LCUEL aaaa> 

W UQ 
w uu 
w v~ 
w uu 
VYW 

uu 

ARIA 1T1Trl RARA 
IA AA 1T llR fll 
IA Fft 1T RR AR 
IARIFR 1T ARARlll 
IA Fft 1T llR I'll 
IA FR 1T AR Ill 

Fill In UDl.I" I.SERIO aid PASSUDID ind prt•• EHTER 
(¥&111~ p•••Lm~d •Ill n1~ •ff"••~ wh1n 9au t9f11 It~ 

USEJI l[J ·-> I 4*----------~ 
P R5&1.1JRD ·-> 
C DmR'IEJ ·->-

AAFAA 
Fiii llFI 
RR RR 
RRFA 
Rll Fill 
RR RR Log in 10 

the IBM host 
here 

HUNKING YIFIUFITFIR 

(This screen shows an Avatar initial screen; your IBM host's initial screen 
will surely be different.) 
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Positioning the Cursor 

By mouse - Move the cursor as you normally do on the Macintosh; click 
once to position the cursor. 

By keyboard - Here are the default actions of some basic keys: 

Key: Moves the cursor: 

EJ and GJ Along a line, character by character. 

C1J and GJ Up and down. 

( HOME) On an unformatted screen, to the upper left comer of the screen. 

On a formatted screen, to the first input character on the screen. 

( RETURN ) To the first input character on the next line. 

( TAB J To the first character in the next input field. 

( BACKTAB J To the first character in the current or previous input field. 

Like a light pen alternative - To use your cursor like an IBM terminal 
light pen in the MMF Workstation 3270 window: 

1. Move the mouse cursor to where you want it. 

2. Hold down the X key. 

3. Click the mouse. 

MMF Workstation moves the host cursor and selects the item. 

For more on MMF Workstation's light pen feature, see Chapter 5. 
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How to Find the 3270 Function Keys 

Click on the Keyboard Help icon: 

Or use the Keyboard selection in the Settings pull-down 
menu. (This selection also shows reconfiguration possibilities.) 

_m_ .J!ll.. IXl2 lr'ID [Jr.I 

In PFI FFl4 Prll> II~ ~ llnat DHF ...... Rlicll 

'" NI "'11l Int ~1 ..... i..w. !;.I~ .......... [ ll]rA, 
..fil.. _ffi.!._ II [!!!_ J'!1 --™- _.!-'!_ 
rn l'Plt 1'917 ms - ••• :!!: - rM -.... 1111:'11 ~ ..... ~ ~ ... ~ ~ -"'"'-

7 I 'I t .. !I c . 
I II ll 

t-i-a-1 
I DIC Rau1rl 
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Changing the 3270 Window's Characteristics 

You can modify several of the 3270 window's characteristics: 

• Font sizes- Use the font size palette on the right side of the 3270 
window. 

• Colors - Go to the Session Settings box. 

• Size, shape, and position of the 3270 window - use the scroll bars, 
size boxes, and the Windows pull-down menu. 

Notice that the palettes, scroll bars, and Keyboard Help button remain 
even when you size the window down: 

The 3270 Window 

~o try2:1 0~ 
UIRTUAL MACHIHE/SYSTE 7 

9 
10 

LU 3 
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Using Multiple 3270 Windows 

K CUT This feature is not available on MMF CUT Workstations. 
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You can have up to eight 3270 windows open at once (depending on your 
Workstation and the availability of LU sessions from the IBM host.) 

Once you have more than one 3270 window, you can use the Windows 
menu to manipulate the windows. The following sections explain how. 

REMEMBER: 

• 

• 

To get a new window, you must start a new LU session. (Each time 
you start a new session, you automatically get a new window.) Use 
the New Session ... selection in the File menu. 

Closing a 3270 window (either with the close box or the Hide 
Session selection in the Windows menu) removes the window from 
view but does not terminate the LU session. 
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Stacking and Tiling the 3270 Windows 

When you have more than one 3270 window open on your screen, you can 
arrange the windows neatly on your screen by using the Stack 
Windows and Ti I e Windows selections in the Windows pull-down 
menu: 

XH 
HJ 

Stack Windows will rearrange all your 3270 windows into a neat 
overlapping stack of same-sized windows: 

Untitled;~ 

Untilled:Z 
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And Tile Windows will rearrange your 3270 windows into a side-by­
side display of same-sized windows: 

m~ Untitled :1 ~El5 

Stack Windows and Tile Windows do not affect the way your 
network connections work or the way you enter or select data in your 3270 
windows. 
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Hiding 3270 Windows 

Sometimes it's useful to clean up your MMF Workstation screen; you might 
have several LU session running but you're using only one at the moment. 

MMF Workstation lets you hide 3270 windows from view but not terminate 
their LU sessions. To do this: 

1 . Select the window to hide. 

2. Go to the Windows menu and select Hide Session. 

Jump Seuion XJ 
Steck Windows 
Tile Windows 

Example: we had two LU sessions; we hid Untitled:l. Untitled:l now 
shows up in the Windows menu with a triangle beside it to indicate that it is 
a hidden window: 

A Untitled:1 3€1 
Untitled:2 3€2 

(Clicking the 3270 window's close box does the same thing as Hide 
Session.) 

To Restore A Hidden 3270 Window 

Use the panel at the bottom of the Windows menu; the name of each hidden 
window has a triangle beside it. 

To retrieve retrieve a hidden window, we can select it here with the mouse 
or we can press X and the window's number. For example, to get 
Untitled: 1 in the illustration above, we would select Un tit I e d: 1 in the 
panel, or we would press X 1 . 
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Visiting Windows In Order 

You can visit your 3270 windows in the order of the numbers in their title 
bars. To do this, use the Jump Session selection in the Windows 
menu. 

Stock Windows 
Tile Windows 

Jump Session goes only to active 3270 windows; it does not go to hidden 
3270 windows. 

REMEMBER: To go to any window directly, either 

• Click on the window with the mouse; or 

• Pull down the Windows menu, go to the bottom panel, and select the 
specific 3270 window you want; or 

• Press X 1 , X 2, etc., according to the number in the window's title 
bar. 

Selecting and Using Data From the 3270 
Screen 

MMF Workstation lets you copy data from the 3270 window and 

• Paste it elsewhere in the window, 

• Paste it into another 3270 window. 

• Log it to a file, or 

• Paste it to another application's window. 

The following sections explain how to do these things. 
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Selecting Data 

First, make sure you're in the 3270 window. 

To select a small area of the 3270 screen 
1 . Highlight the area by dragging the mouse across it. 

2. Release the mouse. 

MMF Workstation will copy the data and will preserve the font size. 

To select the entire 3270 screen 

Pull down the Edit menu and select Select Screen: 

Undo 

Cut :)(:({ 
C(lJl~J :)(:[ 
coii~J r.:1tlle :;c:-r 
P <l ~ h~ :)(:U 

Select Screen :~:A 

MMF Workstation will copy the data and will preserve the font size. 
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Logging Selected Data To A File 

After you've selected data, you can send a copy of the data to the MMF 
Workstation screen log file. 

The menu selections for logging screen data are: 

Follow these steps: 

Page Setup ... 
Print Selection XP 
Soue Selection Rs ... 
Log File ... 
Log Selection to... XL 

Upl<1<1d .. , 

1. Select the data, as described in the previous section. 

2. Pull down the File menu and select Log Selection to .... 

The data goes to the screen log file. 

Saue Selection Rs ... , Log Selection To ... 
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Both Saue Selection As ... and Log Selection To ... perform the 
following modifications: 

• 
• 

Insert CR (carriage return) characters at the end of the IBM line . 

Convert all white space (SPACEs, TABs, NULLs, attribute bytes) to 
SPACEs. 

The 3270 Window 



The Screen Log File 
The screen log file is useful for: 

• Building a collection of screen captures - you can put them all in one 
file, one after the other. 

• Recalling long command lines, then pasting them in at the cursor. 

To open a new Screen Log file or to change the name of the file to which 
MMF Workstation should log selected screen data, select Log Fi I e from 
the File menu. 

You '11 see this file box: 

10 MMF /GW Client I 
i"' M<t< l l ~S2 ·10 Sm1•<ff Q c::l Mnrketing ~ •• I ,., 

1\11\iJ" ·· l:aS~JK•~l.tSl°JJJJI l-• !mm ( ) ¢l NEHl 
!i!Ii! 

l:J•~c1 

i"'I N•~hm>rk ~12·10 ( ) ...... ::1::t 
Drh•<~ 

[) r;.s1···12.2•u~~> JI 
[) ri-Sl ···brnn t11~m~ IQ 

Choose log file: ( Saue ) 

( Cancel ) 

Type in the name for the Screen Log file under Choose log file:. 

If the new file already exists, MMF Workstation will ask you: 

Rppend to eHlstlng file? 

([ No )J Yes ) 
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Saue ) 

Cancel ) 
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Answer yes or no. 

• 

• 

Yes means MMF Workstation will append the new data to the 
existing data in the file. 

No will cause MMF Workstation to send you back to file box for a 
new file name. 

Supply a new file name. 
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Copying And Pasting Selected Data 

To send selected data to a location other than the Screen Log file, you must 
also copy the data in addition to selecting it. 

The menu selections for copying and pasting screen data are: 

llndo 

Cut XK 
Copy XC 
Copy Tobie XT 
Poste XU 

Select Screen XR 

Copying Selected Data 

Pull down the Edit menu again and select Copy or Copy table. 

Copy Tob 
P<1~h~ 

Select sc 

Cut 
Copy 

:)(:2 

:)(:({ 

xc 
ropy Table :~in 

Select screen XR 

A copy of the data now goes to the Macintosh clipboard. 
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Copy 

Copy performs the following modifications: 

• Converts all white space (SPACEs, TABs) to SPACEs. 

Copy does not insert any extra CR (carriage return) characters; this helps to 
preserve the text's original line-wrapping. 

Copy Tobie 

Copy Tab I e performs the following modifications: 

• Strips leading and trailing SP ACEs. 

• Converts two or more SPACEs to T ABs. 

• Inserts a CR (carriage return) character at the end of the IBM line. 

Copy Tab I e is useful for copying data into spreadsheets. 
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Pasting Selected Data 

You can paste selected data back into the 3270 window, to another 3270 
window, or to another application's window. The following sections 
explain how. 

Pasting to a 3270 window 
1 . Select the data, as described above. 

2. Copy the data, using either Copy or Copy to b I e, as described 
above. 

3. Position the cursor in the MMF Workstation 3270 window where you 
want the upper left corner of the data to start. 

REMEMBER: This position must be a valid input field. 

4. Select Post e from the Edit menu. 

MMF Workstation inserts the data at the cursor. 

Pasting to Other Applications 
1. Make sure you're running the MultiFinder. 

2. Select the data, as described above. 

3. Copy the data, using either Copy or C op y to b I e, as described 
above. 

4. Go to the other application's window and paste the data, using 
whatever paste facility the application offers. 
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Chapter 5 

Using the MacMainFrame 
Workstation Keyboard 

Introduction 
Whenever you're in a MMF Workstation 3270 window, your Macintosh 
keyboard acts like a 3270-style keyboard. 

When you pause in your work in the 3270 window, you can make some 
changes to the way your keyboard works. For example, you can rearrange 
the 3270 key functions on your Macintosh keyboard. 

This chapter shows you how to: 

• View your keyboard set-up. 

• Get all the the 3270 key functions, both on your keyboard and on 
screen menus. 

• Redo your keyboard set-up. 

• Construct Easy Keys, which let you record frequently-used key 
sequences for easy playback. 

• Use the MMF Workstation cursor like a light pen. 
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The Basic Keyboard 

MMF Workstation fully emulates the keyboard functions of the 87-key 
typewriter keyboard on IBM 3278 and 3279 terminals. 

Three Keyboard Menus 
The three keyboard-related menus are: 

r s File Edit •Y:UIIID i-W Windows Fu nction Key~ 
h•lan ... 

1m -·- -" Untitle!!'-' ... --·- ...... ....... ..... ... .. . .. 
H 

·~ t-1 Get this menu by selecting 1:-1 

t=I I~ 
t-1 Key boa rd ..• from the 
•1 

Settings menu. lj 

rr 
... Get this menu by 
... pulling down the 
,,. Function Keys menu. • 

~•lvJ1J1lrlr ul•~l•J<ltJ 7.1• • t 

Ill J_•_l_sl•l•l Gj_ Nj_"1_ •J_1J_:_l·j_- tl• . - 1912 .... PP.M • • .. .. 

_l_•lofcl"l•I•J"l·l·I •J ~ ~·I·I I•I .:I-!l. ti' I . 

I DK , ~ ~ ~ 11 
Get this menu by clicking 
the Keyboi:ird Help button. 
~·I-I _l_ff .. I-9[.i.I-tJ I • I · I I 

---- ~ ~ ---Woll ICll J.l ~ 
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Macintosh Keyboard Support 

MMF Workstation assigns the 3270 key functions to your Macintosh 
keyboard. MMF Workstation supports Macintosh and Macintosh­
compatible keyboards. 

CONTROL Key On Small Keyboards 
To get the CONTROL key on the Macintosh 512Ke and Macintosh Plus 
keyboards, hold down the 3€ and OPTION keys together. 
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Viewing Your Keyboard Set-Up 
To find out which 3270 function is where on your Macintosh keyboard: 

• Click on the Keyboard Help icon. 

OR 

• Pull down the Settings menu and select Keyboard ... 

as described below. 

There Are Always Five Variations 
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REMEMBER: There are actually five variations of the keyboard: 

• Plain 

• With OPTION key held down. 

• With CONTROL key (or X-OPTION for 512Ke Macintoshes and 
Macintosh Pluses) and held down. 

• With X key held down. 

• With SHIFT key held down. 

To see each keyboard variation, hold down the key and the contents of the 
window will change accordingly. 
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Keyboard Help Button 

Keyboard 

The Keyboard help button is in the lower right comer of the 3270 screen: 

Click on the question mark and the following window will appear: 

(Here's the window for the smaller keyboard:) 

Hm 

Del PF3 
ete 

Clr PF 
10 

PF7 PFS 

PF4 PF5 

PF1 PF2 

Reset 

PF ~ 11 

PF9 Ins 
ert 

PF6 Del 
ete 

PF3 
En 

Er ter 
EOF 

Keyboard Help is a floating window and it stays in front of all nonfloating 
windows. To make this window go away, click on the close box. 
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Keyboard ... Selection in the Settings Menu 

Printout 
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To view your keyboard and make modifications to it, pull down the Settings 
menu and select Keyboard.... You'll see a box with all the 3270 
functions across the top and a keyboard map across the bottom: 

PF1 PF7 
PF2 PFS 
PF3 PF9 

PF4 PF10 
PFS PF11 

PF6 PF12 

(( OK )J 

PF13 PF19 Alt-Blank Backspace Curs Blink Enter 
PF14 PF20 Alt-Cur Back Tab Curs Sel ErEOF 
PF1S PF21 Alt-Del Blank Delete Erlnp 

PF16 PF22 Alt-Ins Blank2 DevCncl FM 
PF17 PF23 Attn Clear Dup Home 

PF18 PF24 *" ~ +- -+ 
Choose a function key from palette 

\ 

Ctl 

Reuert Print 

PF PF PF 
13 14 15 

Hm 

~:~ PF3 

l+-[I]-+I 

ldent Print 
Insert Reset 

Newlin<> ~sReq 

PA1 Tab 
PA2 Test 

t "' 

Clr PF PF PF 
10 11 12 

PF7 PFS PF9 Ins 
ert 

PF4 PFS Pf 6 Del 
eW 

PF1 PF2 PF3 En 

Reset Er ter 
EOF 

Cancel 

To get a printout of the five keyboards, click on the Print button: 

<:1'1111 \ 

€ Opt Ctl 

Print 
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And you11 get a printout on the Chooser printer that looks something like 
this. (Naturally, your printout will vary depending on your Macintosh 
keyboard.) 

~- I .. 
., I ' t 

4 II " -I It I 

D 

~= I t 

7 .. • • 
4 II " -I t iJ 

II 

l_tt_ • I .. 
l~I .,. . not 

.... "" .. ~ 
"" J. i 

II . ,. 

To look at the five keyboard layouts without printing them, hold down the 
X, CONTROL, OPTION, and SHIFI' keys and watch the keyboard map 
change. 

Modifications 

Keyboard 

To make modifications to your keyboard layout, see the "Re-mapping Your 
Keyboard" section later in this chapter. 
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How To Type 3270 Keys 
You can get almost every 3270 function key two ways: by typing on the 
keyboard or by clicking a screen item with the mouse. 

Typing Keys On The Keyboard 

1. Look up the 3270 key function on one of MMF Workstation's 
keyboard maps, as described in "Viewing Your Keyboard," above. 

2. Type the appropriate key on your Macintosh keyboard. 

Typing Keys On The Screen 
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There are two ways to type keys by clicking the mouse: 

1. The Function Keys tear-off menu, and 

2. The Keyboard Help button in the 3270 window. 

REMEMBER: To see more keys, hold down X, SIIlFT, and so on. 

To type any screen key, just click the mouse on the key once. (Grayed keys 
won't click; you'll have to type those from the keyboard.) 

Keystrokes Go to the LU Session 

When you type a key - either with the keyboard or on the screen - the 
keystroke will go to the active 3270 window's LU session. 
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• 

Re-Mapping Your Keyboard 
You can change the way the 3270 keys are mapped to your Macintosh 
keyboard. 

You may want to do this because you're used to a different keyboard 
layout, because you find a particular layout that suits you, or because you 
want to omit certain keys so you don't type them by accident. 

The following sections describe how to use the Keyboard ... Selection in the 
Settings menu to change your keyboard layout. 

Keyboard ... Selection in the Settings Menu 

Keyboard 

MMF Workstation comes with the 3270 keys assigned to keys on your 
Macintosh keyboard. You can change these assignments by using the 
Keyboard ... selection under the Settings menu. 

1. Pull down the Settings menu and select Keyboard ... 

Reset Session 
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You'll see the following dialog oox- 3270 functions are at the top 
and the keyooard is at the bottom: 

PF1 PF7 PF13 PF19 All-Blri Back~ce unBlink En\or Iden\ Print 
PF2 PFB PF14 PF20 Alt-Cur BackT•b Curs Sol ErEOF lnsort Rt sot 
PF3 PF9 PF15 PF21 Alt-Dol Blank Dtloto E~ ~wlint ~R!!. 
PF4 PF10 PF16 PF22 Alt-Ins Blank2 DtvCncl FM PAI Tab 
PF5 PF11 PF17 PF23 Attn Cl.ar Dup Horne PA2 Tost 
PF6 PF12 PF18 PF24 *' ~ +- -+ ..!. ..:!.. 

Choose a function key from palette 

~ ff 1 ff2fr3EF41 frsfr,lmfrsl Fr91 ~~I)~ I~~ 11 )~I)~ I)& I 

(Here's the keyooard map for a smaller keyooard:) 

PF 
Ii 14 1~ 

DWO\ol El" ro 

( CIK , ( Reuert Print ) ( cancel ) 
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Keyboard 

2. Make sure the cursor is an arrow: 

J, II 
a 

If it's not, click this box until it changes to the arrow. 

3. Look at the palette at the top of the Function Keys box and pick the 
new function you want to assign to the key: 

Pfl PF7 PF13 PFl9 AH-Blank !ao~- Clrs Blink Ent tr ldtnt Print 
PF2 PFB PFl4 PF20 AH-cur BaokTab CUrsS.1 ErEDF lnstrt Rtstt 
PF3 PF9 PFIS PF21 Alt•Dtl Blank Dtlttt Erlnp tff"tlllfnt SysRtq 
PF4 PF10 PFl6 PF22 Alt-Ins Blank2 DtVCnol FM PAI Tob 
PFS PF11 PFl7 PF23 Attn Clear Dllp HO!M PA2 Test 
PF6 PF12 PFl8 PF24 *' ... .. ... ..!. ~ 

Click on the function you want to assign. 

4. Look at the keyboard in the bottom of the box and decide where you 
want to assign the function. REMEMBER: You may have to hold 
down X, CONTROL, SIIlFf, or other modifier keys to get to the 
key you want. 

OK Reuert Print Cancel 

Click on the key, and MMF Workstation will assign the function to 
that key. 
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To Get A Printout 

To get a printout of the keyboard, which will show the current function-to­
key assignments, click the Print button. (This printout will go to your 
current Chooser printer.) 

REMEMBER: The printout will contain five different keyboard layouts, one 
for plain, one for OPTION-key, one for CONTROL-key, one for X-key, 
and one for SHIFT-key. 

To Undo Your Work 
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To put the keyboard back to the layout it had before this invocation of the 
Keyboard Settings box, click on the Re u e rt button. 

The Cancel button also reverts your work, and it closes the window. 
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To Remove A 3270 Function 

Keyboard 

You can remove a 3270 function from a key and leave the key with its 
original function. This is useful in the case of the numeric keypad - you 
may want to use the keypad to type numbers again rather than PFl, PF2, 
etc. 

To remove a function from a key: 

1. Make sure the cursor is an eraser: 

J, II 

If it's not, click this box until it changes to the eraser. 

2. Look at the keyboard in the bottom of the box and choose the key 
from which you want to erase the 3270 function. REMEMBER: You 
may have to hold down K, CONTROL, SHIFT, or other modifier 
keys to get to the key you want. 

Reuert Print Cancel 

Click on the key, and MMF Workstation will erase the function from 
that key. 
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To Return To The Defaults 

To get a keyboard that has the default settings that MMF Workstation 
offers, open a new Session Settings document (by pulling down the File 
menu and selecting New). 

To Test Your New Key Assignment 
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You can test your new key assignment right away; you don't have to save 
your set-up or restart MMF Workstation. (But do save your setup in a 
Session Settings document if you want the key assignments to be 
permanent.) 

To test the.key assignment, either: 

• Type the key on your physical keyboard, or 

• Click on the Keyboard Help button (lower right corner of your 3270 
window), then click on the key in the Help window. 

REMEMBER: Hold down CONTROL, SIIlFT, etc. too, if that's how you 
configured the key. 
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The Function Keys Pull-Down Menu 
The main purpose of this menu is to let you type function keys by clicking 
with the mouse. You can also use it to create a private function key palette. 

Typing Keys 

Keyboard 

To type a key, pull down the menu until the mouse cursor is over the key 
and release. 
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Tearing Off The Menu 
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If you want to look around a bit before you type, or if you want to create a 
palette, tear off the Function Keys menu. To do this, pull down the 
Function Keys menu but keep dragging the mouse all the way through. 
When you see the outline of a free-floating window on your screen, release 
the mouse. Now you'll see this floating palette: 

Settings Windows Function Keys 
----

-------~--- ---- Untitled: I 
~CHIHE/SYSTEM PRODUCT 

- -
=-~~-~-~--- --=--~.::::-
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Customizing the Function Keys Menu 

Keyboard 

You can use the Function Keys pull-down menu to make a small window 
that contains function keys, which you can click on as you work. Here are 
a few examples. 

These windows can be very handy, especially since you don't have to find 
the key on your Macintosh keyboard in order to type it. 
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Steps: 

1. Tear Off The Menu 
Click on the Function Keys menu in the menu bar and drag the mouse all 
the way through the menu before releasing. 

2. Rearrange The Keys 
To rearrange the keys in the palette window: 

1. Hold down the X key (the cursor will change to a hand) and 
click on one key. Let's pick PA2: 

2. Still holding down X, drag PA2 to where you want it to be in 
the window - let's say you want it to be where PF2 is. 

3. Release the mouse and the X key - PAI and PF2 will swap 
places. 

Undoing Key Rearrangements 
To undo a key rearrangement, swap the keys back again. 
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3. Size The Palette 

Keyboard 

To size the Function Key Palette down around only those keys you want to 
display, hold down the OPTION key. You'll see the lower right key-square 
change to a sizing box: 

_JI I .... ! _ __.1 

~BB 
][!]~ 

Still holding down OPTION, grab the sizing box with the mouse and size 
the window. 

Notice that you can size the window so that blank space is added, if you 
want: 
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4. Move the Palette 
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To move the palette, grab the title bar with the mouse and drag it. The 
palette is a floating window, so it will stay in front of all nonfloating 
windows until you close it. 

To make the palette window go away, click on the close box: 

To reopen the palette window, pull down and tear off the Function Keys 
menu again. The window will reopen, and it will remember your 
rearrangements. 

When you save your MMF Workstation set-up in a Session Settings 
document, MMF Workstation also saves the settings of this window. 

Keyboard 



Using EasyKeys 
The Easy Keys feature lets you record a sequence of keystrokes and then 
play them back by pressing a single X-key combination. 

For example, you could record the keystroke sequence, "Accounting Files" 
under the key combination X9. To get "Accounting Files" to go in at the 
3270 cursor, just press X 9 (or whatever X-key combination you select at 
recording time). 

To record, edit, and play back Easy Keys, use the Easy Keys pull-down 
menus described in the following sections. 

To Record An EasyKey 

Keyboard 

1. Go to the 3270 window. 

2. Pull down the EasyKeys menu and select Start Recording. 

EasyKeys 
Start Recording 
Edit ... 

3. Type all the keys you want to record. 
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4. To end the sequence, after you type the last key, either 

• Type a host AID key. Examples: 

( ENTER ) 

( CLEAR J 

@D through [ PA 3 J 

~ through (_P_F_24_} 

• Or pull down the EasyKeys menu again and select Stop 
Recording: 

Easy Keys 
Stop Recording 
l: di1 ,,, 
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Keyboard 

Easy Keys will now present you with the following dialog box: 

EasyKey To Edit: I Neu1 £8syKey I 
~ 

None 
B 
0 

List This EnsyKey Sequence Rs: E 
F I New EnsyKey I 

_<'![,. 
6 

(( I 
I 

OK ( RNJt~rt ) ( Ht~mt>ut~ ) (Cam K 
M 
R 
u 
y 
I 

0 

5. Fill out the box: 

• Optionally, select the X-key combination that you want to 
trigger your recorded sequence by selecting it from the X-key 
pop-up menu. 

• Supply a new name for your Easy Key by typing it in the List 
This EasyKey Sequence As: panel. 

• Change the keystrokes that will comprise the Easy Key by 
clicking inside the scroll box and then using the DELETE key 
and BACKSPACE keys, cutting and pasting, and so on to edit 
the keystrokes. 

When you're done, click 0 K; or to undo the Easy Key assignment and 
discard the recorded keys, click C 8 n c e I. 
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Items In The EasyKeys Dialog Box 
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EnsyKey To Edit: This is a pop-up menu that displays all the 
EasyKeys in the current Session Settings file. 

Scroll box: This box shows the keystrokes that comprise the EasyKey. 

List This EasyKey Sequence Rs: Type the name you want the 
EasyKey to have. You can supply a name up to 31 characters long. 

X Key: This is a pop-up menu that lists the available X-key 
combinations. 

K OK D 
"ii~ iiiiiiiiiiiiiiiiiiiii1 confirms your edits, assignments, and removals and 
closes the EasyKeys dialog box. 

( Reuert ) applies to edits; it restores the EasyKey you've been editing 
to what it was before this invocation of the EasyKeys box. 

( Rem OU e ) removes the Easy Key from the Session Settings document. 
(The removal is not permanent until you Save the Session Settings 
document.) 

( Cancel ) cancels whatever you've done in the EasyKeys box, including 
clicking the Remoue button and the most recent editing of an EasyKey. 
It then closes the EasyKeys dialog box. 
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To Play Back an Easy Key 

There are two ways to play back an Easy Key: 

• Type the X-key combination for the EasyKey, 

OR 

• Pull down the EasyKeys menu and select the key you want. The 
available keys are listed in the bottom section of the menu: 

EasyKeys 

St8rt Recording 
Edit ... 

New EasyKey 3 x 9 ) Aveiileble EesyKeys 
New EasyKey 4 KO 



To Edit An Easy Key 
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1. Select Edit from the EasyKeys menu. 

You'll see the EasyKeys configuring box again. 

2. To edit the Easy Key, click the cursor into the scroll box: 

abcxyzl 

3. Type in additional keys if you wish; or use the DELETE key and 
BACKSPACE keys, cutting and pasting, and so on to get the 
keystroke sequence you want. 

4. When you're done editing, click one of the following: 

• 

• 

• 

0 K to confirm the new keystrokes . 

Reuert to discard the edits and restore the EasyKey to what it 
was before you started editing it. 

Cance I to discard the edits, cancel everything else you did in 
the box, and close the box. 
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Light Pen Feature 

Keyboard 

You can use the MMF Workstation mouse cursor like a light pen as follows: 

For applications that support light pens: 

• 

• 

• 

Position the mouse cursor in the 3270 window at the item you want to 
select. 

Hold down the X key. The mouse cursor will change to a lighted 
cursor. 

Click the mouse button once to make the selection . 
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Chapter 6 

Introduction to File 
Transfer 

MacMainFrame's file transfer capability lets you transfer files between your 
Macintosh computer and an IBM mainframe host. Transferring a file to the 
host is called uploading; transferring a file from the host is called 
downloading. 

By using the different kinds of transfers that MacMainFrame's file transfer 
capability offers, you can exchange Macintosh and non-Macintosh files 
among Macintosh and non-Macintosh machines. 

To use MacMainFrame's file transfer capability, you: 

1. Provide information about the host machine by selecting Host ... 
from the Settings menu. 

2. Select Upload or Download from the File menu, according to 
what you want to do. 

This chapter introduces the following topics, with which you need to be 
familiar in order to use MacMainFrame's file transfer capability correctly: 

• The environment on the IBM host machine. 

• Tran sf er formats. 

• Multiple LU sessions 

• Batch processing 

Chapter 7 lists the steps to perform all file transfers and describes the items 
in the Upload/Download dialog boxes. 

Chapters 8, 9, and 10 list the dialog boxes you'll see when you transfer 
files to and from CICS, VM/CMS, and TSO operating environments, 
respectively. Chapter 11 describes how to batch process your file transfers. 
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To look up a file transfer in those chapters: 

1. Turn to the chapter for the particular operating environment: CICS, 
VM/CMS, or TSO. 

2. Then turn to the first half of the chapter for Uploads, the second half 
of the chapter for downloads. 

3. Then turn to the page that describes the transfer format you'll use: 
text, binary, or document. 

4. Finally, look at the top of the page if you're using Avatar's HFT 
software, the bottom of the page if you're using IBM's HFT 
software. 

Terminology: For convenience, we'll refer to MacMainFrame's file 
transfer capability as MMF FT hereafter. 

The Host Environment 
MMF FT lets you transfer files to and from three IBM host environments: 
CICS, VM/CMS, and TSO. 

Before you perform a file transfer, you must let MMF know which IBM 
environment you're running to. (You do this with the Host ... selection in 
the Settings pull-down menu.) 

As you petform the transfer, you'll fill out slightly different 
Upload/Download dialog boxes depending on the IBM environment you 
selected. 

The Host-Resident File Transfer Software (HFT) 
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For the IBM host to petform its side of the transfer, there must be HFT 
(host file transfer) software running on the host. With MMF FT software, 
you can use IBM's HFT software or you can use Avatar's HFT software. 
(Names of IBM and Avatar HFT programs are listed in Chapter 7 .) 

Before you petform a file transfer, you must specify which host-resident 
HFT software you'll be using. You do this in the same dialog box in which 
you specify the host environment. (Pull down the Settings menu and select 
Host .... ) 
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Transfer Formats 
The term transfer format refers to the way a file's contents is changed while 
it is being transferred. MMF Ff uses three transfer formats: Text format, 
Binary format, and Document format (which is sometimes called 
MacBinary format). 

The following sections explain the formats in which you can transfer files 
with MMF Ff, and they describe what changes, if any, a file goes through 
when it is transferred in each format. 

Macintosh Files 

While you don't have to know much about the internals of Macintosh files, 
we provide the following information for your convenience; it is useful in 
understanding the differences among MMF Fr's three transfer formats. 

Internally, Macintosh files have three parts: 

Header - Contains basic information about the file, such as its name. 

Data - Contains the file's data. 

Resources - Contains formatting or other Macintosh-application-specific 
information. 

According to which format you choose, MMF Ff transfers all or some of 
these parts. 

Text Format 
When MMF Ff transfers files in text format, it transfers only the text - no 
control characters, no font information, no formatting. 

Introduction to File Transfer 6-105 



Useful For 
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Text format is useful for text data that can withstand translation without loss 
of meaning. (Example: the word "MacMainFrame" in ASCII code comes 
out the same in EBCDIC - "MacMainFrame. ") 

Many files contain simple ASCII text with no formatting characters (other 
than TABs and SPACEs, which are themselves ASCII characters). If 
you're not sure how a document will look when it is converted to text-only, 
save the document using one of the following programs: 

• Apple TeachText. 

• Mac Write™ (using the Text Only option). 

Plain ASCII files are good candidates for file transfer in text format; 
executable programs or graphics data are not good candidates. 

To make sure you can send a file in text format, save the file as text-only on 
your Macintosh, regardless of how the application originally saves the file. 
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On Upload 

MMF Fr transfers only the data portion of a Macintosh file. It translates the 
outgoing data from ASCII (native code on the Macintosh) to EBCDIC 
(native code on IBM host machines), converting unprintable characters 
(such as control characters) to spaces. 

Padding and Fragmenting 

TABs 

MMF Fr removes all Carriage Return (CR) characters from text files on 
upload. 

• If the file on the host has fixed-length records but a Macintosh record 
is shorter than the fixed length, MMF FT adds space characters to pad 
the record to that length. 

• If a Macintosh record is longer than the host record length (fixed or 
variable), MMF Ff will break the Macintosh record into as many 
pieces as necessary to fit the host record length. 

MMF FT converts each TAB to one SPACE unless you select the [Hpand 
Tabs option in the Upload box. (For more information on Tab Stops, see 
Appendix C.) 

Introduction to File Transfer 6-107 



On Download 

MMF FT translates the incoming data from EBCDIC to ASCTI, converting 
unprintable characters (such as control characters) to spaces. MMF FT 
creates a Macintosh Mac Write™ text-only file. 

Padding and Fragmenting 

TABs 

• MMF FT removes trailing spaces from the end of each host fixed 
length record. 

• MMF FT adds a Carriage Return (CR) to the end of each record in 
order to create a Macintosh record. 

To cause MMF FT to insert TABs and other control characters into the 
Macintosh record, select Insert Special Characters in the 
download box. (For more information on inserting special characters, see 
Chapter 7, How To Transfer A File.) 

Binary Format 
When transferring a file in binary format, MMF FT transfers only the data 
part of Macintosh files and does no translation of the data. 

Useful For 
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Binary format is useful for: 

• 
• 
• 

Moving the data parts of Macintosh files around unchanged . 

Transferring files belonging to non-Macintosh-specific applications . 

Transferring files between Macintosh and non-Macintosh machines . 
For example, you can use it to move files between an MS-DOS PC 
and a Macintosh using the IBM mainframe as a mail box. (These 
exchanges also require that software on the two machines - the 
Macintosh and the PC - can read the files. Excel™, PageMaker™ 
and Microsoft® Word have built-in translation facilities that allow 
this.) 
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On Upload 

When uploading Macintosh documents in binary format, MMF Ff transfers 
only the data part and does no translation of the data. 

On Download 

When downloading files in binary format, MMF Ff lets you add file type 
and creator type information to the file. This information lets Macintosh 
applications recognize the file; and once the file has a file type, you can 
double-click on the file's icon and the file will start the correct application. 

Available File Types 
Use the Macintosh Filetype item in the Download box to specify the file 
type. The Macintosh file type item is a pop-up menu: 

M11cM11lnFr11me 3270'" - Au11t11r HFT 

O TeHt @Binary O Document Down1011d from UM/CMS 

CMS Fllen11mell "-____ __. 

Flletypej ._ ____ __. 

File mode 

M11clnto1h Fllen11me 

Ouerwr1te EHlstlng File 

(EHecute J 

[Heel WKS 
P11geMaker 2.0 
P11geM11ker 3.0 
MS Word 3.0 
General CAD-CAM Binary 
Oef11ult Blne 

MMF FT lets you save your downloaded files as the following types: 

I Mnemonic I File Type 
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Excel WK---S- Excel™ WKS 

Pagemaker 2.0, PageMakerTM 2.0 & 3.0 
Pagemaker 3.0 

MS Word3.0 Microsoft® Word 3.0 

General CAD-CAM General CAD-CAM bmaiy 
binary 

Default Binary All files 

Default Type: If the first five file types do not fit your application(s), 
choose Default Binary. 

Document Format 
Document format lets you transfer Macintosh documents to and from IBM 
machines intact, that is, with no loss or modification of any part of the 
document. 

The way MMF FT stores Macintosh files on the host is called MacBinary 
Format. MacBinary format is used by other programs in other non­
Macintosh environments, for example, on V AX™NMS machines. 

Useful For 

Document format is useful for Macintosh-to-Macintosh document 
exchanges where an IBM machine is the file server. One Macintosh can 
store exact copies of documents on the IBM host; later, another Macintosh 
can retrieve them. 

On Upload 
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When uploading files in MacBinary format, MMF Fr transfers the entire 
Macintosh document. Neither MMF Fr nor the host performs any 
translation of the file's contents. 
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This means the file is not usable by the host, although the host can move 
and copy the file. 

On Download 

On download, the IBM machine gives you back the complete Macintosh 
file. Inside this complete Macintosh file, the original Macintosh filename is 
preserved, even if the Macintosh file had another name on the IBM host 
You can retrieve this Macintosh name now by selecting Use n 8 me 
from host file image in the download box. 

Background/Foreground Processing 
It's not necessary to wait for a MMF Ff file transfer to finish to go back to 
work. You can either use multiple LU sessions to run the file transfer in the 
background, or you can batch your file transfers. The next two sections 
describe these options. 

Using Multiple LU Sessions 

To use multiple LU sessions, run the file transfer in one LU session, then 
go to another LU session to resume work. The file transfer will continue to 
run in the first LU session. 

Batching Your File Transfers 

To run your file transfers in batch, collect the transfers into a batch file, then 
run the batch file later at your convenience. For complete information on 
using MMF Fr's batch feature, see Chapter 12. 
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Chapter 7 

How To Transfer A File 

Introduction 
This chapter describes the steps you follow with MMF Ff to perform all file 
transfers. 

For additional information about a specific file transfer, see Chapters 8, 9, 
and 10. 

Overview 

There are five steps for all file transfers: 

1. Check the host settings: select Host ... from the Settings menu and 
fill out the resulting dialog box. (This step needs to be done only once 
per IBM environment.) 

2. Select Upload or Download from the File menu. 

3 . Fill out a file box. (The file box is optional on download.) 

4. Fill out the resulting upload or download dialog box. 

5. Confirm the transfer: click EHecute, Cancel, or Batch in the 
upload/download box. 

The following sections describe each step in detail. 
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Before You Start 
Make sure you have: 

• Names and formats of the files you want to transfer. 

• Information about the IBM host. 

• A second LU session available, if you want to go back to work and 
not wait for the file transfer to finish. 

1. Check The Host Settings 
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NOTE: This step needs to be done only once per IBM environment. 

Pull down the Settings menu and select Host... . MMF FT will display 
the following dialog box: 

I BM Host Type 0 CICS 0 UM/CMS 0 TSO 

IBM Host File Trnnsfer @ Auntnr O I BM 

HFT Program Nome ._II _________ __. 

(( OK J) ( Cnncel ) 

Fill out the dialog box as follows: 

I BM Host Type Click on the operating environment that is running at 
the IBM host, either CICS, VM/CMS, or TSO. 

IBM Host File Transfer Specify whether the file transfer 
software, which resides at the host, is IBM's (called IND$FILE) or 
Avatar's (called HFT). 
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HFT Program Name Supply the name of the host-resident file 
transfer software according to this table. 

The standard names are: 

If you're using: And The IBM Enter this HFT 
environment is: program name: 

Avatar's HFT CICS RRR3 
TSO TSOHFT 
VM/CMS CMSHFT 

IBM's IND$FILE CICS IND$ 
TSO IND_!FILE 
VM/CMS IND$FILE 

When you're done, click the 0 K button. 
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2. Select Upload or Download 
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Pull down the File menu and select Upload or Download according to 
the transfer you want to perform: 

Nt~UI 

Clp<~n ... 
Close 
New Session 
flHHIOll(~ St~S~ 

Sa11e 
So11e As ... 

N•~w :•:N 
CIJ1<rn ... :•:o 
Close XW 
New Session... XN 
fl<ml<W<~ S•~s~ion ... 
SalJe XS 

................................................. Sa11e As ••• 
Page Setup ............................................................................................ . 

Print St~h~cti: Page Setup •.• 
snuf.> S<~le< ti! Prin1 St~h~c1ion ... :•:P 
Log file... SOIJI.' S<~l<H tion Os ... 

l.01.1 S<~l<~< tio1 Log file ... 
................................................. l.o~i S<~IH< tion to... :•:L. 

Upload ... 
Download ••• 
Del<l1<~ Ho~t I 
Batch File ... 
D<11<h -rrnnsf 

Quit 

Upload ... 
Download ... 
D<~l<!f e Ho~ t file ... 
Batch File ... 
U.:1t<h "frnnsfer ... 

Quit 

How To Transfer A File 



3. Fill Out the File Dialog Box 
The file dialog box is different depending on whether you're uploading or 
downloading. 

File Box For Uploads 

All uploads automatically present you with a file dialog box first. (Click the 
Select button in the Upload box to get back to this box.) 

la demo folder! 

CJ sales.letter :tl c:> JR E's HD-40 

( [ j(H t 

( Dril1e 

Open 

Cancel 

Choose a file to upload 

Upload type: @Te Ht O Binary O Document 

Use the box just like a regular Macintosh file dialog box. 

Transfer Format 

Note that you can now supply the format in which you would like MMF FT 
to transfer the file by using the Upload type: radio buttons-TeHt, 
Binary, and Document. 

How To Transfer A File 7-117 



File Box For Downloads 
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On downloads, the file dialog box is optional. 

To get to this box, Click the Sau e As button in the download box . 

la Uarious MMFI 

r.~ ·5.no S•~rnN ~ c::i Auatar 
r.~ fHISP 
~ flPfl ·~;~<1'1 I 

( [j•~i:1 ) 
Ot flPfl ·5;5() 1 ( Urili<~ ) 
Ot on ~~-21> I 
f.) mi cur fQ 

Saue downloaded file os: ( S<HI(~ ) 

( Cancel ) 

Use the box just like a regular Macintosh file box. 

Sau e term in a I file as: MMF FT creates a name here, basing it on 
the IBM filename, that the downloaded file will have when it arrives at the 
Macintosh. 

Change this name if you wish by typing in a new name. 
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4. Fill out the Upload/Download dialog box. 
MMF will then display an Upload/Download dialog box. 

Fill out the requested information in the Format section, the From-file 
section, and the To-file section. (See the diagram below.) 

Then click EHecute, Cancel, or Batch according to what you want. 
(For more information on batch processing, see Chapter 11.) 

Here's a sample Upload/Download dialog box. (The dialog box you get 
will vary depending on the type of transfer you're doing.) 

MacMainframe 3270™ - Auatar HFT 

Format { 
-tf---

® TeHt O Binary O Document Upload to CICS 

From-file { Macintosh filename test ( Select ) 

To-file 

Confirm { 

---
CICS Filename 

Record Size ~ 

D EHpand tabs 

Ouerwrite EKisting File O Yes O No ® Rsk First 
=tt:== 
-tt---

(EHecute) [Cancel) ( Batch ) 

Items in the Upload/Download Dialog Boxes 

D Append CR to each line 

This item tells the IBM host to add a carriage return (CR) character to each 
line of text or binary data it downloads to the Macintosh. 
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D Rppend to Host File 

This item tells the IBM host to perform an append, not an overwrite, during 
upload. 

Block Size 

In this item you may supply the number of characters that the TSO 
destination file should have on upload. 

Default = 80 characters. 

Maximum = 99999 characters. 

CICS Filename 

MMF Ff creates a name here, basing it on the Macintosh filename, that the 
uploaded file will have when it arrives at the IBM host. 

Type in a new name if you wish, but be sure to follow the host's naming 
conventions. 

CMS Filename 

MMF Ff creates a name here, basing it on the Macintosh filename, that the 
uploaded file will have when it arrives at the IBM host. 

Type in a new name if you wish, but be sure to follow the host's naming 
conventions. 

D CR is record separator 
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On Uploads, tells the IBM host that the carriage return character in the 
uploaded file is the record separator character. 
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(Directory J 

The Directory button lets you view the files that are on a CICS host. 
Click the button to see a directory dialog box. For more information, see 
Chapter 8. 

Available only when Avatar HFf software is running on the host. 

D EHpand Tabs 

This item lets you specify an alternate TAB-to-SPACE conversion scheme 
on uploads of text files, as follows: 

When IBM HFT is running When Avatar HFT is 
on the host: running on the host: 

D Each ASCII TAB---+ 1 EBCDIC Each ASCII TAB ---+ 1 EBCDIC 
TAB SPACE 

~ TABs---+ SPACEs according to TABs---+ SPACEs according to 
the spacing on the Tab Stops the spacing on the Tab Stops 
dialog box's ruler.* dialog box's ruler.* 

* When you select EH p B n d TB b s (when you click the check box to ~), 
MMF FT first displays a dialog box that lets you redefine the TAB settings. 
The Tab Stops dialog box is described in Appendix C. 

File mode 

You must supply the CMS file mode here. 
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File type 

You must supply the CMS file type here. 

Format: TeHt, Binary, Document 

Identifies the file's contents by data type and limits the way transmitting 
software handles the data during transmission. 

Does not modify the contents of the original file in any way; only affects the 
file's copy that arrives at the destination .. 

D Insert special characters 
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On downloads, you may tell MMF Ff to change certain letter combinations 
in the arriving file to special characters. 

To use this option, you must insert the letter combinations in the host text 
file and select Insert Special Characters in the text-format 
download box. 
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The table below provides examples of the special characters that you can 
insert on the host. 

When this MMF FT changes it to this 
letter special character: 
combination 
arrives: 

't TABs 

\J) BACKSPACE 

\n NEW LINE (Line Feed) 

\r RETURN 

\f FORM FEED 

\v VERTICAL TAB 

'-0## A byte value in hexadecimal code.* 

* MMF FT interprets this as an ASCII character. EXAMPLE: \005 
becomes the ASCII TAB character on the Macintosh. 

CAUTION: Make sure the hex code corresponds to a valid ASCII character. 

Macintosh Fiiename 

When uploading: Type in the name of the Macintosh file you're uploading. 

When downloading: MMF FT creates a name here, basing it on the IBM 
filename, that the downloaded file will have when it arrives at the Macintosh 
machine. 

To view the current files on your Macintosh, click the Se I e ct button. See 
the Se I e ct item in this list for more information. 
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Macintosh Filetype 

You may supply a Macintosh file type here. 

This is a pop-up menu - click on the item to get the menu:. 

Mac:intosh File Type [Heel WKS 
PageMaker 2.0 
PageMaker 3.0 
MS Word 3.0 
General CAD-CAM Binary 
Default Binary 

And scroll down or up to select the file type you want 

Member Name 

If the TSO data set is partitioned, supply the member name; otherwise, leave 
blank. 

Number of Records 

You may change the number of records per transfer. 

Default = 1000 records. 

Maximum = 99999 records. 

Ouerwrite EHisting File 0 Yes 0 No @ Rsk First 0 
Append 
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You may specify whether or not MMF Ff should replace an existing file on 
your Macintosh with the new file that arrives in the download. 
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Rsk First (which is the default) lets you reject the overwrite without 
aborting the download - you supply a new filename instead, and MMF 
writes to that file. 

Record Format 0 FiHed ® Uariable 0 Undefined 

You may supply the format that the uploaded file's records should have in 
the destination file. 

Default = Variable 

Record Size 

You may supply the number of characters per record that the destination file 
should have on upload. 

MMF FT supplies a default record size. 

( Saue Rs ) 

On downloads, if you want a different filename for the arriving file than the 
name MMF FT creates, click this button. MMF FT will give you a file box: 

I~ DemD Folder I 
Ds111es Letter <::>HD 40Meg 

i:jl~C1 

Driue 

Snue termlnnl file 11s: Siwo 

[ Concel ) 

D Lock file 

Fill out the Saue terminal file as: item with the file name you want. 
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Click the Sau e button to save the file under the new name and leave the 
box, or click the Cance I button to leave the box without changing the 
name under which to save the file. 

( Select ) 

If you want to change the name of the Macintosh file you're uploading, 
click the Se I e ct button, and MMF FT will present you with a file dialog 
box: 

lesi demo folder( 

D >ale>.letter ~ 

Choose t1 file to upload 

= JRE's HD-40 

[ l:je< t ) 

[ llrit•e ] 

Open 

( Cancel 

Upload type: ® TeHt O Binary O Document 

Use the box to find the file you want; select the file, then click the 0 pen 
button to ready the file for transfer. 

MMF FT will open the file, close the box, and return you to the 
Upload/Download box. 

TSO Allocation 
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On upload, supply the allocation for the file on the host; you must use 
standard TSO file allocation commands here. 
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TSO Data Set Name 

Supply the TSO data set name of the file you're going to upload. (See TS 0 
F ii e Name for downloads.) 

NOTE: A partitioned data set must have been previously created on the host. 

TSO File Name 

You must supply the name of the file from the TSO environment that you 
wantto download. (See TSO Data Set Name for uploads.) 

D Use name from host flle image 

On downloads, MMF Ff names the arriving file what it was named on the 
IBM host. 

If the file was uploaded in MacBinary format, checking this item will give 
you the file's original Macintosh name, even if it had another name while it 
was on the IBM host. 

Transfer Format 

Note that you can respecify the format in which you would like MMF FT to 
transfer the file by using the radio buttons now: Te Ht, Bin a ry, and 
Document. 
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5. Confirm the Upload/Download. 
When you're finished filling out the upload/download dialog box, click the 
EHecute, Cancel, or Batch button; the buttons are at the bottom of 
the box. 

11 
(EHecute) ( Cancel ) Batch 

II 

(EHecute) 
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If you click EH e cute, MMF Fr will perform the upload or download and 
it will display a status window to show you the progress of the file transfer: 

Transfer for Untitled:! 01 
MacMainFrame 3270"' - R11ator HFT 

- Macintosh - -[I]~ -CMS-

- STATISTICS - - STATUS -

BVTES TRRNSFERRED lnltlallzlng 

Current file •••••• 0 ~ Synchronizing with HOST 

Total •••••••••••• 0 
Creating Host file 
Transferring Data 

TRANSFER COUNT Rending Macintosh file 

Transaction •••••• 1 of 1 Writing Host file 
End of file 

Transferred • • • • • • 0 End of transmission 
File transfer ABORTED 

Press X-. to abort this trnnsnctlon 

(This window is described in more detail in the next section.) 

When the file transfer is finished, the status window disappears. 

REMEMBER: You don't have to watch the Status window; you can go 
back to work immediately by switching to another LU session and resuming 
work there. 
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( Batch ) 

MMF Ff will record into the batch file you specify all the information you 
supplied in the upload/download dialog box and in the Host Settings box. 
Later, you can run the transactions in this batch file by selecting Batch 
Transfer ... from the File menu. 

For complete information on MMF FT's batch feature, see Chapter 11. 

( Cancel ) 

MMF FT discards all the information you've provided in the 
Upload/Download box, performs no file transfer, closes the box, and 
returns you to the 3270 session window. 
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The File Transfer Status Window 
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The File Transfer Status window is an information box that shows the 
progress of the file upload or download. 

This sample window shows the progress of a file being uploaded to a 
VM/CMS environment: 

Tnmsfer for Untitled: 1 

MacMainFrame 3270™ - R1Jatar HFT 

- Macintosh - -~~ 
- CMS -

- STRTISTICS - - STATUS -

BYTES TRRNSFERRED Initializing 

0 

Current file .•..•. 0 ~ Synchronizing with HOST 

Total •••••••••.•• 0 
Creating Host file 
Transferring Data 

TRANSFER COUNT Reading Macintosh file 

Tnmsoction .•..•. 1 of 1 Writing Host file 

Transferred .•••.• 0 
End of file 
End of transmission 
File transfer ABORTED 

Press 3€-. to abort this transaction 

(When you're in the Load Status box, your cursor will also change to a 
small animated hand, like the ticking watch the Finder displays.) 
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Elements of the File Transfer Status Window: 

D 

) 

The arrow shows the direction of the transfer: 

An upload appears as - Macintosh - ....+ - (I BM) -. 

A download appears as: - Macintosh - ~ - (I BM) -. 

The icon in the center of the arrow shows the format in which the file is 
being transferred: 

Text format Binary format Document format 

- STATISTICS -
STATISTICS displays how many bytes have been transferred, and how 
many transfers have occurred. 

- STATUS - and ~ 
The pointing hand indicates which process in the STATUS list is occurring 
at that moment. The hand moves up and down the STATUS list as the file 
transfer progresses. 
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Errors And Troubleshooting 
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If you fill out a field in the Upload/Download dialog box incorrectly, MMF 
FT will beep or blink the screen but will not perform the transfer (or if you 
clicked Batch, will not log the transaction to the batch file) and will wait 
for you to supply correct information. 

If you're in doubt about a field, MMF FT often fills in default values where 
it needs them; try the default first. 
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Chapter 8 

File Transfers To/From CICS 

Introduction 
This chapter lists all the file transfers you can perform with MMF Ff to and 
from a CICS environment. 

How to Use This Chapter 

Uploads: See the beginning of the chapter. 

Downloads: See the end of the chapter. 

If you're using Avatar HFT: See the dialog boxes on the top of the 
page. 

If you're using IBM HFT: See the dialog boxes on the bottom of the 
page. 

Within the Upload section, the transfers are: first Text format, then Binary 
format, then Document format. Within the Download section, the order is 
the same. 

For special CICS-related features - viewing a deleting files on the CICS 
host - see the next two sections. 
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Viewing Files on the CICS Host 

8-136 

If you have Avatar HFf running on the host, you can view files there. To 
do so, use the Directory button, which appears in the download dialog 
boxes: 

- Ruotar HFT 

Download from CICS 

(Directory) 

This button gives you the following directory dialog box, which lets you 
view the files on the host: 

Directory for 3279:1 0 

~ Directory Status 

Initializing 
~ Synchronizing with Host 

Reading Directory 
Ending Session 
Aborting Session 

( Ct1<10~•~ ) 

tQ 
( CmH t~! ) (Hefre~h) 

Press X-. to abort 

The HFT software will display the files in the scroll list. Scroll up and 
down to view the files. 

• To select a file to transfer, select the file in the scroll list by clicking 
the mouse, then click the Choose button. 
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• To quit the dialog box without selecting a file, click the Cancel 
button. 

• To get an updated listing of the files, click the Refresh button. 
Refresh is useful since files may be added to or deleted from the 
directory while you are working. 
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Deleting Files on the CICS Host 
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To delete a file on the CICS host: 

1. Make sure you have Avatar HFf software running on the host. 

2. Pull down the File menu and select Delete Host File .... 

3. Use the resulting dialog box: 

Macintosh Moinfrome Link 

CICS Delete 

CICS Filename !~I ______ ~I ( Directory ) 

(EHecute) (Cancel ) Botch 

Supply the name of the file you wish to delete. 

Notice the Directory button; you can use this button the same way 
as in the CICS download boxes - to view files on the CICS host. 

4. Click EHecute, Cancel, or Botch. 

NOTE: The actual deletion of the file takes place when the CICS system 
administrator runs the Purge program on the CICS host. 
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Uploads - Text Format 

Using Avatar HFT 

MacMalnFrame 3270™ - Ruatar HFT 

®Te Ht 0 Binary 0 Document Upload to CI CS 

Macintosh Fiiename test ( Select ) 

CICS Filename 

Record Size ~ 

D EHpand tabs 

Ouerwrite [Histing File O Yes O No ® Rslc: First 

(EHecLite) (Cancel ) ( Bntch 

Using IBM HFT 

MacMainFrnme 3270™ - IBM HFT 

® TeHt O Binary O Document Uplond to CICS 

Macintosh Fiiename test 

CICS Filennme 

(EHecute) 

File Transfers To/From CICS 

1:81 CR Is record separator 

D EHpnnd tabs 

(Cancel ) ( Botch 

( Select ) 
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Uploads - Binary Format 

Using Avatar HFT 

MacMalnFrame 3270™ - Ruatar HFT 
O TeKt ®Binary O Document Upland to CICS 

Macintosh Fllennme test ( Select ) 

CICS Filename 

ouerwrlte EKlstlng Fiie O Yes O No ®Ask First 

(EKecute) ( Cnncel ) ( Bntch ) 

Using IBM HFT 

MacMalnFrame 3270™ - IBM HFT 

O TeKt ®Binary 0 Document Upload to CICS 

Macintosh Fiiename Release Notes ( Select ) 

CICS Filename 

D CR Is record sep11r11tor 

(EKecute) (Cancel ) ( Botch 
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Uploads - Document Format 

Using Avatar HFT 

MacMalnFrame 3270™ - nuatar HFT 

QTeHt O Binary ®Document Upload to CICS 

Macintosh Filename Sales ( Select ) 

CICS Filename .._II ______ ___. 

Ouerwrite [Histing File O Yes O No ® Ask First 

(EHecute) (Cancel ) ( Batch ) 

Using IBM HFT 

MacMalnFrame 3270"' - IBM HFT 

QTeHt O Binary ®Document Upload to CICS 

Macintosh Filename Release Notes ( Select ) 

c I cs Filename 

(Ettecute) (Cancel ) ( Batch ) 

Downloads - Text Format 
When you're downloading from a CICS environment and Avatar HFf 
software is running on the IBM host, you can view and delete files on the 
host. For information about these features, see the beginning of this 
Chapter. 
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Using Avatar HFT 

MacMalnFrama 3270"' - R1111tar HFT 

® TllHt O Binary O Document Download from CICS 

CICS Fiiename 

Macintosh Fiiename 

(Directory) 

( S11ue Rs) 

O Insert specl11I characters 

Ouerwrlte [Histing Fiie O Yes O No ® Rsk First 

Using IBM HFT 
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MacMalnFreme 3270"' - IBM HFT 

®Teat O Binary O Document Download from CICS 

Cl cs Fiiename 

Macintosh Fiiename ( Saue Rs J 

0 Insert special characters 

Duenurlte [Histing Fiie O Yes 0 No 

® Rsk First O Append 

181 Rppend CR ta each llne 

[cancel) ~ 
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Downloads - Binary Format 

Using Avatar HFT 

MacMalnFrame 3270™ - Ruatar HFT 

O TeHt @Binary O Document Downloacl from CICS 

CICS Filename 

Macintosh Filename 

Macintosh File Type [Heel WKS 

(Directory) 

( Saue Rs ) 

ouerwrlte £Histing File O Yes O No @ Rsk First 

(EHecute) (Cancel ) ( Batch 

Using IBM HFT 

MacMainFrame 3270™ - IBM HFT 

QTeHt @Binary O Document Downloocl from CICS 

CICS Filename ~II _______ __. 
Moclntosh Fllenome [ Sriue Rs ) 

Moclntosh File Type [Heel WKS 

Ouerwrite [Histing File O Yes O No 

@ Rsk First O Rppencl 

D Append CR to each line 

(EHecute) ( Ccmcel ) ( Batch ) 
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Downloads - Document Format 

Using Avatar HFT 

MacMainFrome 3270™ - Ruatar HFT 

QTeHt O Binary @Document Download from CICS 

CICS Filename ..... II _______ _. 
Macintosh Filename 

(Directory) 

( Saue As ) 

D Use name from host file image 

Ouerwrite [Histing File O Yes 0 No @ Rsk First 

( EHecute) ( Cancel ) ( Batch 

Using IBM HFT 

MacMainFrame 3270™ - IBM HFT 

OTeHt O Binary @Document Download from CICS 

CICS Filename 

Macintosh Filename ( Saue As ) 

D Use name from host file image 

Ouerwrite EHisting File O Yes 0 No 

@Rsk First 

(EHecute) ( Cancel ) ( Batch 
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Chapter 9 

File Transfers To/From VM/CMS 

Introduction 
This chapter lists all the file transfers you can perform with MMF Ff to and 
from a VM/CMS environment. 

How to Use This Chapter 

Uploads: See the beginning of the chapter. 

Downloads: See the end of the chapter. 

If you're using Avatar HFT: See the dialog boxes on the top of the 
page. 

If you're using IBM HFT: See the dialog boxes on the bottom of the 
page. 

Within the Upload section, the transfers are: first Text format, then Binary 
format, then Document format. Within the Download section, the order is 
the same. 
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Uploads - Text Format 

Using Avatar HFT 

Using IBM HFT 
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MacM11lnfr11me 3270'N - R1111t11r HFT 

® TeKt O Bln11ry O Document Upload to PM/CMS 

Macintosh Filename sales.letter 

CMS Filename l.._s_R_L_u ____ __, 

Filetype l._L_m_ER ___ __. 

Fllemode §=:] 
Record Size ~ 

Record Format ® FIHed QUari11ble 

0 EHpand tabs 

MacMalnFrame 3270"' - IBM HFT 

® TeHt O Binary O Document Upload to UM/CMS 

Macintosh Fiiename sales.letter 

CMS File Name ~l~·~l~il~i~~~~~ 
Fiie Type ... I L_ET_TER ___ __. 

FlleMode ~ 

Record Size ~ 

Record Format O FIKed ® Uarlable 

O Append to host file C1SI CR Is record separator 
D EHpand tabs 
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Uploads - Binary Format 

Using Avatar HFT 

MacMalnFnime 3270~ - Huatar HFT 

O Teat ® Binary O Document Upload to UM/C:MS 

Macintosh Fiiename Sales ( Select ) 

CMS Filename jsnm 
Flletype I LETTER 

File mode §::J 
(Eaecute) (Cancel) [!!§] 

Using IBM HFT 

M11cMalnFrame 3270'" - IBM HFT 

O Teat ® Binary O Document Upload to UM/C:MS 

Macintosh Filename sales.letter 

CMS Fiie Name ~lli~O~IS~~~~~ 
File Type ._I L_ETT_ER ___ __. 

FlleMode ~ 
Record Size ~ 

Record Form11t O Flaed ® Uarlable 

D Hppend to host me D CR Is record sep11r11tor 
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Uploads - Document Format 

Using Avatar HFT 

Using IBM HFT 
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M11cM11lnFnime 3270"' - Au11t11r HFT 

QTeHt O Binary @Document Upload to UM/CMS 

Macintosh Fiiename sales.letter 

CMS Filename n1~"'~i~li~iliili!i!ll 
Filetype ~' L_E_TI_E_R ___ __. 

Filemode D 

MacMninFr11me 327D'M - IBM HFT 

O TeHt O Binary ®Document Upload to UM/CMS 

Macintosh Fiiename sales.letter 

CMS File Name 

File Type '~L_ETI_ER ___ ~ 
FileMode D 

Record Size ~ 

Record Format O FiHed ® Uarioble 
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Downloads - Text Format 

Using Avatar HFT 

MacM11lnFr11me 327D'M - Ruatar HFT 

® TeKt O Binary O Document Download from BM/CMS 

CMS Fiiename 

File type 

File mo de [!!:::] 
Macintosh Filename ( S11ue Rs J 

D Insert spec1111 char11cters 

Ouerwrlte EKlstlng Fiie O Yes O No ® Rsk First 

Using IBM HFT 

M11cM11lnFr11me 3270'M - IBM HFT 
®TeKt O Bln11ry O Document Download from BM/CMS 

CMS File Name H 
:=::::========: 

Flletype !,_ _____ _. 

Fllemode [!!:::] 
Macintosh Filename ( S11ue Rs) 

D Insert speclol characters 

Ouerwrlte Ealsting File 0 Yes 0 No 

® Rsk First O Rppend 

181 Append CR to each llne 
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Downloads - Binary Format 

Using Avatar HFT 

MacMalnFrame 3270"' - Ruatar HFT 

O Teat @Binary O Document Download from UM/CMS 

CMS Filename 

File type 

Fllemode ~ 

Macintosh Filename ( Soue Rs) 

Macintosh Fiie Type ._E_H_ce_l_W_K_s ____ __. 

ouerwr1ta Ealstlng Fila O Yes O No ® Rsk First 

Using IBM HFT 
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MacMalnFrame 3270"' - IBM HFT 

0 Teat @Binary O Document Download from UM/CMS 

CMS File Name 

Flletype 

Fllemode ~ 
Moclntosh Fiiename ( Soue Rs) 

Macintosh Fiie Type Eacel WKS 

Ouenurlte EHlstlng Fiie O Yes O No 

@Ask First O Rppend 

D Append CR to eoch llne 
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Downloads - Document Format 

Using Avatar HFT 

M11cMoinFr11me 3270'" - Rua tor HFT 

QTeHt O Binary ®Document Download from UM/CMS 

CMS Filename 

Flletype 

Filemode §::=J 
Macintosh Filenome ( Soue Rs J 

D Use name from host flle Image 

Ouenurlte EHlstlng File O Yes O No ® Rslc First 

Using IBM HFT 

MacMalnFrame 3270'" - IBM HFT 

O TeHt O Binary ® Document Download from UM/CMS 

CMS Fiie Name 

Flletype 

Fllemode ~ 
Macintosh Fiiename [ Saue Rs J 

D Use name from host flle Image 

Ouenurlte [Histing File O Yes O No 

® Rslc First 
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Chapter 10 

File Transfers To/From TSO 

Introduction 
This chapter lists all the file transfers you can perform with MMF Ff to and 
from a VM/CMS environment. 

How to Use This Chapter 

Uploads: See the beginning of the chapter. 

Downloads: See the end of the chapter. 

If you're using Avatar HFT: See the dialog boxes on the top of the 
page. 

If you're using IBM HFT: See the dialog boxes on the bottom of the 
page. 

Within the Upload section, the transfers are: first Text format, then Binary 
format, then Document format. Within the Download section, the order is 
the same. 
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Uploads - Text Format 

Using Avatar HFT 

MacMainFn1me 3270'M - Auatar HFT 

® TeHt O Binary O Document Upload to TSO 

Macintosh Fiiename sales.letter [ Select J 

TSO Data Set Name 

MemberName 

Record Size ~ 

Block Size ~ls_o_o __ ~ 

Number of Records ~I 1_0_0_0_~ 

Record Format ® FIHed QU11rl11ble 

D EHpand tabs 

[cancel) 

Using IBM HFT 
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MacMalnFrame 3270'M - IBM HFT 

® TeHt O Binary O Document Upload to TSO 

M11clntosh Filename sales.letter 

TSO Fiie Name 

Record Size ~ Block Size i aoo 
:::==-~~~~_..:::====: 

TSO Aliocetlon 

Record Form11t O FIHed ® U11rl11ble O Undefined 

D Append to Host File l:i!:I CH Is record separator 

D EHpand tabs 
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Uploads - Binary Format 

Using Avatar HFT 

MacMalnFrama 3270~ - Ruatar HFT 
O TeHt ®Binary O Document Upload to TSO 

Macintosh Filename sales.latter 

TSO Data Set Name 

(EHecute) 

Using IBM HFT 

MacMalnFrame 3270~ - IBM HFT 

O TeHt @Binary O Document Upload to TSO 

Macintosh Fiiename SBlas.letter 

"' "'" ,_, 1 · 

:::::=::::;-~~~~-;::====: 

Record Size ~ Block Size i soo 
:===-----===:::::: 

TSO Rllocatlon 

Record Format O FIHed @ Uerleble O Undefined 

D Append to Host Fiie D CR ls record separator 
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Uploads - Document Format 

Using Avatar HFT 

Using IBM HFT 
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MacMelnFrome 3270"' - Ruatar HFT 

O TeKt O Binary ®Document Upload to TSO 

Macintosh Filename sales.letter 

TSO Data Set Name -' s_R_LE_s_.L_ETT_ER _______ ~ 

MncMalnFrame 3270"' - IBM HFT 

O Te Kt 0 Binary ®Document Upload to TSO 

M11clntosh Filename s11les.letter 

TSO Fiie Nome 

Record Size @D Block Size lsoo 
:::::==-----====~ 

TSO Rllocntlon 

Record Format 0 FIKed ® Uoriable O Undefined 
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Downloads - Text Format 

Using Avatar HFT 

M11cM11inFr11me 3270"' - Ru11t11r HFT 

® TeHt O Bln11ry O Document Downlo11d from TSO 

TSO D11t11 Set N11me 

Member Name 

Password 

Macintosh Fiiename 

D Insert special chorocters 

Ouerwrlte [Histing File O Yes O No ® Rsk First 

Using IBM HFT 

MacMainFrame 3270'" - IBM HFT 

® TeHt O Binary O Document Download from TSO 

TSO File N11me 

Mnclntosh fllen11me [s11ue Rs J 

D Insert speciol chorocters 

Ouerwrlte [Histing File O Yes O No 

File Transfers To/From TSO 

® Rsk First O Rppend 

181 Rppend CR to e11ch llne 
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Downloads - Binary Format 

Using Avatar HFT 

M11cM11infr11me 3270™ - R1111t11r HFT 
O TeHt ®Binary O Document Download from TSU 

TSO Date Set Name 

Password 

Macintosh Fiiename 

Macintosh File Type [Heel WKS 

D11erwrfte [Histing Fiie O Yes O No ® Rslc First 

Using IBM HFT 
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MacMalnframe 3270'M - IBM HFT 

O TeHt @Binary O Document Download from TSO 

TSO File Name 

Macintosh Filename ( Sn11e Rs) 

Macintosh File Type [Heel WKS 

011erwrite EHlstlng File O Yes O No 

® Rsli: First O Rppend 

D Rppend CR to each llne 

[cancer) ~ 
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Downloads - Document Format 

Using Avatar HFT 

MacMalnFrame 3270"' - Ruatar HFT 
O Teat O Blna111 Ii> Document Download from TSO 

TSO DBtll Set Name 

Password 

Macintosh Fiiename 

D Use nam• from host file Image 

Ouerwrite EHl1tlng File 0 Yea 0 No ®Rik First 

Using IBM HFT 

MacMainFrame 3270"' - IBM HFT 

O TBHt O Bln11111 Ii> Document Download from TSO 

TSO Fiie Name 

Macintosh Fiiename 

D Use name from host file lm11ge 

Duerwrlte Ealstlng Fiie O Yes O No 

Ii> Rsk First 
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Chapter 11 

Batching Your File Transactions 

Introduction 
MMF Ff lets you set up several file transactions for execution as batched 
transactions. 

The transactions you can perform in batch are: 

• Uploads 

• Downloads 

• File deletes (CICS environments only, providing Avatar HFf 
software is running at the host.) 

Running your MMF Ff transactions in batch is useful for: 

• Delaying the execution of transactions to a more convenient time. 
(You don't have to be logged on to the host when you set up the batch 
transactions, but you do have to be logged on when you execute 
them.) 

• Recording the transactions so that you can repeat them several times. 

The following sections describe the steps to batch your file transactions. 
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1. Identify the batch file. 
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You must tell MMF Ff the name of the file that will contain the batched 
transactions. 

1. Pull down the File menu and select Batch Fi I e ... 

MMF Ff displays this dialog box: 

la Client I 
Q M<H t-foini: rmrH~ ·~2 .. , ~ c:inuatar 
D MMF" .. [l~SHK•~•.1srrnp 

( ) D H<rnd M<~ ··· I: f it~n t E:j•~c1 

Cl These go in System ... ( Dril'<~ ) 
D 1r~}l 

lQJ 
Batched transactions file: ( Saue ) 
I MocMoinFrome Batch I ( Cancel ) 

The scroll box displays a list of possible Batch files. 

2. Select a file from the scroll box, or fill out the box with the name of 
the file that MMF FT should use as the batch file. 

3. Click the Sau e button. 

Default name = MacMainFrame Batch. 

MMF Ff will save in this file all subsequent transactions that you designate 
as batch, until you specify a new batch file (by pulling down the File menu 
and selecting Batch File ... again). 
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2. Set up the transaction(s). 
To set up a transaction, follow the same steps as with all file transfers: 

1. Pull down the Settings menu and supply the host information. 

Pull down the File menu and select Upload or Download, and fill out 
the resulting Upload/Download dialog box. 

2. For the last step in the Upload/Download dialog box, click the Botch 
button at the bottom of the box: 

II 
(EHecute) (Cancel ) l:Mdil 

II 

(or the Botch button at the bottom of the CICS Delete box). 

MMF FT now saves your transfers in the batch file. (The batch file is 
a Macintosh text document and you can read it with a word 
processor.) 

If you haven't opened a batch file already, MMF FT will ask you to 
do so now: 

lesi Client I 
~ i-rnc Muinl: r<1rr1<~ ·~2 ... IQ =nuotor 
Cl MMr-fosyK•~~4srrni1 
D Jl<rnd Mc~ - [ lh~nt [ E:,j•~i:1 l 
CJ These go in System ... [ Uril• (~ l 
Cl 1r~j1 

KE 
Botched tronsoctions file: ( soue l 
I MocMoinfrome Botch I ( Cancel ) 

3. Specify as many batch transactions as you want; Uploads, 
downloads, and file deletes can all be saved to the same file. 

Make sure all the transactions are for the same host environment, for 
example, all for CICS or all for VM/CMS. 
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3. Run the batch file. 
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1. Make sure you're logged on to the IBM host with MMF Workstation. 

2. Pull down the MMF Workstation File menu and select Batch 
Transfer ... . You'll see the Batch Transfer dialog box: 

la Client I 
D jbatc:hl ~ 
D MacMainFrame Batch 
D Read Me 
D soles letter 

c:::::> Au a tar 

( Open ) 

( Cancel ) 

3. Select a batch file, and click the 0 pen button to have MMF FT run 
the file. 

If the host cannot complete a transaction in the batch file you select, MMF 
FT skips the transaction and goes to the next one. 
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Chapter 12 

Using MacMainFrame 3287 

Introduction 

)( CUT MMF 3287 is not available on MMF CUT terminals. 

MMF 3287 is an application that emulates an IBM 3287-style printer. 

MMF 3287 lets you route an IBM print stream to a printer that's connected 
to your Macintosh or that resides on your local AppleTalk network. This 
printer can be a LaserWriter™, for example, which you select from your 
Chooser. You can also route the print stream to a disk file on your 
Macintosh. 

Once you have established the LU session that will carry the IBM print 
stream, any user that has access to the host end of that LU session can 
submit print jobs to the session and the print jobs will print on your 
Chooser printer. 

Once MMF 3287 is running, it automatically accepts print streams and 
automatically routes the streams to your Chooser printer. MMF 3287 
breaks up the IBM stream into individual Macintosh print jobs. This 
prevents the IBM stream from monopolizing the printer. 

As with other MMF products, you can save your MMF 3287 parameter 
settings in a Macintosh document, and you can restart MMF 3287 from the 
document (as well as from the MMF 3287 application itself). 
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What You Need First 
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To use MMF 3287, you must have: 

• 

• 

Software that communicates on the network to both the IBM host and 
your printer. Use the MMF Workstation software. (For instructions 
on installing MMF Workstation, see the appropriate installation guide; 
MMF Workstation installation guides are listed in the Preface.) 

Access to the IBM host. Use MMF Workstation. (For information 
about the availability of host connections on your network, see your 
network administrator.) 
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How To Install MMF 3287 

1 . Make sure you have a Printer LU session. 

Go to the Control Panel, select the Avatar icon, and in the LU panel, change 
one of the LU sessions to Printer. (If you've already done this and 
restarted your Macintosh since then, skip to the next step.) 

To do this, position the cursor over the desired LU and hold down the 
OPTION key. The cursor will change to a double-ended arrow: 

11LU4: +Terminal Jmmf f 

II LU 4 : HT ermina 1 f::::::l I 
Click the cursor to have the LU's type change from Terminal to Printer to 
Graphics to Terminal, and so on. Here, we changed LU 6 to Printer: 

LU 2: Terminal 
LU 3: Terminal 
LU 4: Terminal 

~I L:::~~=~=~ ==~~=~=P:=:r=cs:::::::J 
( on"l m: l'fttnn 1 

REMEMBER: You must restart your Macintosh to have this new setting 
take effect. 
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2. Make sure you have the MMF 3287 files. 

Load the MMF 3287 software that comes on your MMF Workstation 
distribution diskettes and make sure you have the following files:. 

~3287 
MacMainFrame 3287 Armonk 

D 
Armon 

Appendix B contains a key to the MMF Workstation icons. 

3. Install the MMF 3287 application. 

12-170 

Drag the MMF/3287 application from the diskette to a convenient place on 
your Macintosh. 

A separate folder for MMF 3287 is useful since it provides a place for MMF 
3287 Print Settings documents, which you'll generate and use. 

, ............. , 
: : 
i i 
! i 

··.·.-.·.·.·::.·.-.·.-.· .............. .':::::::.-.·:::J 

MMF Folder 
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4. Install the Armonk™ Font 

Make sure your Macintosh System has the Armonk font installed. (Armonk 
is Avatar's proprietary font for use with MacMainFrame Series products.) 
Armonk comes in two parts: 

rill 
Armonk 

Bitmap version of the font 

D 
Armon 

Postscript version of the 
font, for use with Laser 
printers. 

1. Use the Font/DA Mover to install the bittnap version of the font in 
your System: 

w 
Font ID A Mover 

(Or you can double-click on the font icon itself to start the Font/DA 
Mover.) 
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The Font/DA Mover displays a dialog box like this: 

®Font Mouer O Desk Accessory 

Armonk 7 ~ ( [ 01>1,i ) fQ 
Armonk 9 

~ Armonk 10 ( Hl'OH)Uf~ ) 1fff1 11111 Armonk 12 !!U 
Armonk 13 :lilli 
Armonk 14 lb.iii 
Armonk 18 [Q QJ 

system i I on Auator 

I 
[ Help ) 

14183K free 
I ( Close ) i ( Quit ) . ( Open ••• ) I ·-·-.. -----·---.. -·-.. -----· .... -.............. -......... -......... _ .. _ .... , .... _ ......... -.............. -......... ____ .. , ____ .. 

Follow the Font/DA Mover's Help directions to copy the font into the 
System. 

2. Drag the Postscript version of the Armonk font to the System folder: 

("'"····1 
c.f"' '·1 Bm ................... : Armon 

System Folder 
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How to Use MMF 3287 
To use MMF 3287, you start it running, optionally change the print 
parameters, and then enable printing. 

The following sections explain how to do this. 

REMEMBER: MMF 3287 uses the same printer as MMF Workstation -
your Macintosh's Chooser printer. 

How to Start the MMF 3287 Application 

1. Make sure: 

• You've followed the MMF 3287 installation procedures above. 

• MMF Workstation is installed. 

• Your Workstation is connected the IBM host from which you 
want to receive and route print streams. 

• The host has properly set up the LU you're going to use. 

• You've set up the LU to be for Printer in your Avatar control 
panel. 

2. Open the MMF 3287 application by double-clicking on the MMF 3287 
icon: 

~3287 
MacMainFr ame 3287 
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When the MMF 3287 application opens, you11 see the menu bar change 
from the Finder's: 

,.. • Fiie Edit IJlew Speclel Color 

to MMF 3287's: 

r • Fiie Edit 

If you haven't started MMF 3287 from a Print Settings document, MMF 
3287 will open a new Print Settings document for you now. 

MMF 3287 will then display the Print Status window: 

Untitled 

Printing: Stopped 
LU #: unknown 
Current pege: o 
Current Hne: o 
Paa•• par Joll: 1 o 
Job nmeout: 15 1ecand1 
Font: Al'eonk -- 11 
Spacing: Sing le 

End of Line: Tl'uncote 
SCS Commands: Ignore 

Prell•. to stop 

The Print Stanis window tells the status of print streams, if any, that are 
currently going through MMF 3287. 

Since we haven't enabled printing yet, nothing's happening. (To enable 
3287 to print, see "Enabling MMF 3287 to Print" later in this chapter.) 
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How to Change Print Parameters 

To change MMF 3287's print parameters: 

1. Make sure the MMF 3287 application is open. 

2. Make sure no streams are printing and that MMF is disabled from 
printing by pressing X. (COMMAND-period). 

3. Select Page Setup from the MMF 3287 File menu. 

New 
Open ••• 
Close 
Saue 
Snue As ••• 

XN 
XO 
xw 
XS 

4. Click the 3 2 8 7 Setup button in the Page Setup dialog box. (This 
box is for a LaserWriter; the contents of the box varies according to 
the type of printer.) 

_L_ns_e_r_w_n_·t_er_P_n_g_e_s_e_tu ... p ___________ , __ o _ ( OK D 
Paper: @ us Letter O R4 Letter 

MacMainFrame3287 

O US Legnl O 85 Letter 0 I 'Tabloid ( Cancel ) 

Reduce or f1001 3 
Enlarge: ~ 

Orientation 

-~ 
3287 Setup 

Printer Effects: 
181 Font Substitution? 
181 TeHt Smoothing? 
181 Graphics Smoothing? 
181 Foster Bitmap Printing? 

(Options) 

Help 
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MMF 3287 will then display its own setup dialog box: 

=M==a=c=M .... a ... in==F=ra=m=e==3==2a=1=se .... t_u_P __ ==-=--=-1_.o __ n OK J 
Destination: @Printer O Dist (cancel) 

Pages per Job: ~ Job Timeout: @] seconds 

O Interpret SCS Commands 

Font: I RrmonJ: 

End of Line: @Truncate O Wrap 

Spacing: @ Single O Double 

Font Size:~ 

5. Fill out the set-up box according to the "Items in the MMF 3287 Setup 
Box" section below. 

To have MMF 3287 use the changes you made, enable MMF 3287 to print. 
(Pull down the File menu and select Print:) 

New 
Open ••• 
Close 
Saue 
Saue Rs ••• 
Pnge Setup ... 
• 

XN 
HO 
KW 
HS 

To save the changes you made, select Soue or Saue As ••• from the 
MMF 3287 File menu. MMF 3287 will record the settings in a Print 
Settings document: 

~ 
LU 

Untitled 

Saving your print settings is useful because it lets you start MMF 3287 
quickly and easily from the Print Settings document itself. 
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Items in the MMF 3287 Setup Box 

Destinotion: This is where the print job goes. 

Printer-To the Chooser printer. 

Disk- To a disk file on the Macintosh. 

P 8 g es per Job: Maximum number of pages from the IBM print stream 
that MMF 3287 will group together as a single Macintosh print job. MMF 
3287 does not examine the IBM stream or distinguish IBM jobs within the 
stream. 

Job Timeout: H MMF 3287 does not receive any more pages after this 
time period, it will print the pages it has as a single Macintosh print job and 
start a new job for the next page it receives. 

D Interpret SCS Commonds Interpret SNA Character Stream 
commands. 

D Perform minimal SCS formatting. (This is the 
default.) 

Perform general SCS formatting and interpret some 
SCS attributes. 

End of Line: 

Truncate: MMF 3287 will discard data that extends past the width of 
the Chooser printer's print line. Example: A line is 100 characters 
plus CR, but only 80 of those characters will fit on the printer's paper. 
The printer prints those first 80 characters, discards the remaining 
characters up to the CR, and starts printing the next character after the 
CR in the first character position on the next line of the paper. 

Wrap: MMF 3287 will print data that extends past the width of the 
Chooser printer's print line by wrapping it to the next line and printing 
it there. Example: A line is 100 characters plus CR, but only 80 of 
those characters will fit on the printer's paper. The printer prints those 
first 80 characters, starts the next line and prints as many of the 
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remaining characters as possible, and so on until it reaches the CR, 
then starts a new print line as usual. 

Font: The font in which the print stream will appear on the Chooser 
printer. The font choices are Armonk and whatever fonts you have in your 
System. Use the Font/DA Mover to change the fonts in your System. 

Font Size: The size of the font in which the print stream will appear on 
the Chooser printer. 

REMEMBER: A larger font can mean unexpected loss of data at the ends of 
lines if you have End of line: set to Truncate. 

Spacing: The spacing between lines of printed text. 

Single - single-spaced lines 

Double - double-spaced lines. 
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How to Enable MMF 3287 to Print 

1. Make sure the MMF 3287 application is open. 

2. Pull down the MMF 3287 File menu and select Print: 

New 
Open ••• 
Close 
Saue 
Saue Rs ... 
Page Setup ••• 

HN 
HO 
HW 
HS 

3. Next, you'll see the Print dialog box for your Chooser printer. (This 
box is for a LaserWriter called "LW Plus - Engineering.") 

LaserWriter "LW Plus - Engineering " to I[ OK D 
Coples:Ll Pages: ®All 0 From: D To: D ( Cancel ) 

Couer Page: @ No O First Page 0 Last Page Help 

Paper Source: ® Paper Cassette O Manual Feed 

Print: @ Color/Grayscale O Black & White 

Fill out the Print dialog box as you wish. Confirm by clicking 0 K. 
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MMF 3287 will go ahead and start an LU session with the IBM host. Once 
the LU session starts, the IBM host can send print jobs to MMF 3287 for 
printing on the Chooser printer. 

MMF 3287 now displays the Status window, which stays up while MMF 
3287 is running in the foreground whether it is printing or not. (If you're 
running the MultiFinder, you can move MMF 3287 to the background.) 

How to Disable MMF 3287 From Printing 
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To disable MMF 3287 from printing, press X. (COMMAND-period). 

This will cause MMF 3287 to stop printing the ongoing print stream. MMF 
3287 will not accept any more print streams from the IBM host. 

When you disable MMF 3287 by pressing X ., the host sees a power-down 
of the printer that MMF 3287 is emulating and an LU session disconnect. 
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When MMF 3287 Prints 
MMF/3287 prints automatically. 

You can watch the progress of a print job in the Status window, which 
MMF 3287 displays whenever it prints: 

Untitled 

Printing: Stopped 
LU #: unknown 

Current page: 0 

Current line: 0 

Pages per Job: 10 

Job Timeout: 15 seconds 

Font: Armonk -- 11 

Spacing: Single 

End of Line: Truncate 

SCS Commands: Ignore 

Press X • to stop 

Items in the MMF 3287 Status Window 

Printing: Indicates the status of the current Macintosh print job. 

Stopped MMF 3287 is disabled from printing. 

Running MMF 3287 is enabled and is awaiting a print 
stream from the IBM host 

jobname MMF 3287 is currently printing this Macintosh 
print job. 
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LU #:The Logical Unit number, if known, that MMF 3287 is currently 
using. 

Current Page: Indicates the page that is currently printing in the 
Macintosh print job. 

Current Line: Indicates the line number, in terms of the current 
Macintosh print job, that MMF 3287 has received from the IBM host. 

Pages per Job: Indicates the pages per job you selected in the 3287 
setup box. This is the maximum number of pages from the IBM print 
stream that MMF 3287 will group together as a single Macintosh print job. 

Job Timeout: Indicates the job timeout value you selected in the 3287 
setup box. After this time, MMF 3287 will print the pages it has as a single 
Macintosh print job and start a new job for the next page it receives. 

Font: Indicates the font and font size that you selected in the 3287 setup 
box. 

Spacing: Indicates the line spacing that you selected in the 3287 setup 
box. 

End of Line: Indicates the method for handling too-long lines that you 
selected in the 3287 setup box. 

SCS Commands: Indicates whether or not MMF 3287 is interpreting 
SNA Character Stream commands. 
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How to Send the Print Stream to a Disk File 

To have MMF 3287 to send its print stream to a disk file instead of the 
Chooser printer: 

1. Stop the print stream from the IBM host by pressing X. 

2. Go to the MMF 3287 Setup dialog box (pull down Page Setup ... 
from the File menu, and in the Page Setup box click the 3287 Setup 
button) and click the Disk radio button. 

Click 0 K to close the 3287 Setup box. 

3. Select Print from the MMF 3287 File menu. 

4. Next, you'll see a File dialog box: 

la demo folderl 
D >ales.lette1 ~ e>JRE's HD-40 

( f: j<~<t ) 

( 01111(~ ) 

Open 

Cencel 

Spool print stream to: 

5. Fill out the File box. 

Confirm by clicking 0 pen. 
MMF 3287 is now enabled and can accept print streams, which it will send 
to the disk file. 
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Getting A New LU Session for MMF 3287 
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Normally, MMF 3287 uses the LU Session you specify in the LU panel, 
which is part of the Avatar Control Panel. 

You may need to get a new LU Session if you're going to receive a different 
print stream from the host or if the LU Session you want to use is not 
available. 

To get the new session: 

1. Go back to the Control Panel and select the Avatar icon again. 

2. In the LU panel, first change the old LU session back to Terminal by 
clicking on the LU until it changes to anything except Printer. 
(Remember to hold down the OPTION key so the cursor changes to a 
double-ended arrow.) 

11LU4: +Terminal '1mid I 
11LU4: HTerminal f,,,,,,11 

3. Now choose another LU session to be the Printer session. Position 
the cursor over that LU, hold down the OPTION key, and click the 
cursor until the LU's type is Printer. 

LU 2 : Printer 
LU 3: Terminal 
LU 4: Terminal 

1111,.::::~=~=~=~ ==~=;=::;,,=~=~~=~:::.:::::::.J 
(on"'> r:: c:-.,,,+ ..... ) 

4. Restart your Macintosh to have this new setting take effect. 

For more information about LU Sessions, see Chapters 1 and 3. 
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Shutting Down MMF 3287 

Stop Printing, Stop Running 

To shut down MMF 3287, select Quit from the File menu. 

Quit causes the current print stream, if any, to stop printing, and it will 
prevent any further print streams from printing until you re-enable MMF 
3287 to print. Quit also asks if you want to save the current Print settings 
document. 

The IBM host will see a power-down of the printer that that MMF 3287 is 
emulating. 

Stop Printing, Remain Running 

To stop MMF 3287 from printing but leave it running, press X. (That is, 
hold down the X key and while doing so type . (period) once.) 

X. causes the current print stream, if any, to stop printing, and it will 
prevent any further print streams from printing until you re-enable MMF 
3287 to print. 

The IBM host will see a power-down of the printer that MMF 3287 is 
emulating. 
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Appendix A 

MacMainFrame Workstation's 
Menus 

This appendix briefly describes the MMF Workstation software's pull­
down menus. 

Here's a composite screen shot of all the MMF Workstation menus: 

m1I 11!'1!'!1'1 
Hew 

lbidG 
. [11 

.1:11 
u11en ... '' se111111m ... ll!IiI ' 'll:!ll 
Cll~se -·-·-·-·-·-·- Hid• h11iun [~:<! Pll Hast •• 
New set Cut Jump SaHiu1 PFl '" PFlll Pl Slart Racardinlil .... I-« ·-·-·-··-·-·---·-· 
llemoaue COllU 

IC eyll Dani ... Siad: Winda1 [di1 ... 
SaH co11ura11 1118 WIDdOW5 PF::I Pr& Prt-4 Pl -161 i...,n ·-·-·-··-·-··-··-· ................. _____ .................... _ 
Saue Is Pasle 

Resel 5essi -------------·-·-·· ~New Ea~KeJL llN• ·--·---·-·-·- A Unllllad:I Pr.I Prt PrtS .... , ..... -----·-··--·· I a~ Page Se ee1ee11c:nen MR u1m uaa:z PF-4 Pr10 Pr1' Polll 1 
Print Selei:ticn ..• KP 

I l'l'Z3 I a..,. Dop -Sau• Sal•diun fts ... L _J PfS PF11 l"F17 Pollh 

Lag Fila ... .---- I Pr12 II Prn1 I Praf Jl • l[ .. l 4-Lag Sel•c:1ian ta ... tCL PFl'i -+ "" ·-··-·-··--··-··-·-·-·-·-·-··-·· 
Uplud ••• 
Dawn load ... 
01itt> tt> lfoc1 rm1 ... 
BB1Ch Fllll ... 
1a1c h ll'ansrar ... 

·-··-·-----·--··-·-·-·-·-·-··-·-
QUl1 MQ 

K CUT 

""'1l 

llli!..t 

jsu~ 

T.ill 

Yid 

.. 
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Remember: 

Symbol Means: 

There's another screen after you click on the selection. 

There are more selections - slide the mouse down to get 
them. 

Some menus are subdivided into general function areas. Not all selections 
are available all the time. 

File Menu 
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c101e KW 
New leuian... 3CN 
Remm•e -sesilon,,, 
Smue ~S 

Sau& Rs ... 

Pege Setup ... 
Ps·il'Ji ~l'ltH;Hm1... ~p 

'SIUI~ Sel~< Ul>rt 0S ... 

Log me ... 
LIUJ 5elet UiJn tu... )(L 

UpJom1 ... 
Dau~UI Cl<id --· 
De!01 e Hn~ t me ... 
B81Cl1 Fiia ••• 
&.a1c ll rrein~ra~· ... 

OUlt XO 

) 

) 
} 

Open, close, and save new and 
existing Session Settings 
documents; start new LU sessions 
and terminate existing ones, 
removing them from your current 
Session Settings document. 

Save and print data from your 3270 
windows. 

Do file uploads, file downloads, 
and batch transfers to and from the 
IBM host. 

Quit MMF Workstation. 
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Menus 

New 

Open ... 

Close 

New Session ... 

Create a new Session Settings document and 
open the first LU session. 

Open an existing Session Settings document. 

Close the current Session Settings document. 

Start a new LU session and add it to your current 
Session Settings document. 

>C CUT This feature is not available on 
MMF CUT Workstations. 

R e m O II e S e s s i o n . . . Terminate the current LU session and remove it 
from the current Session Settings document. 

Saue 

Seue Rs ... 

Page Setup ... 

Print Selection ... 

Saue Selection 
Rs ... 

Log File ... 

>C CUT This feature is not available on 
MMF CUT Workstations. 

Save the settings of the current Session Settings 
document 

Save the settings of the current Session Settings 
document (filename requested). 

Choose the format of a printed page. 

Print the currently selected material. 

Save the currently selected material to a file 
(filename requested). 

Assign a name to the MMF Workstation screen 
log file. 

This file is for collecting selected data from your 
3270 screen. (See also Copy and Copy Table 
under the Edit menu.) 

L 0 g s e I e c ti 0 n T 0... Append the highlighted area to the MMF 
Workstation screen log file. {Filename requested 
if you haven't done a Log File before.) 
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Upload ... Send a file to the IBM host machine. 

Download ... Receive a file from the IBM host machine. 

Delete Host Fiie ... Delete a host file (CICS environment only). 

Batch File ... Give a name to the batch file that contains the 
batch transfer script 

Batch Transfer ..• Perform a batch transfer. 

Quit ... Stop running the MMF Workstation program, 
take down all the LU sessions, and optionally 
save the Session Settings document 
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Edit Menu 

Menus 

The Edit menu lets you copy data to and from your 3270 window using 
regular Macintosh methods, that is, highlighting areas with the mouse and 
copying, or pasting at the cursor. 

Undo and Cut are usually not available (grayed out) unless you're running a 
desk accessory that enables them. 

Undo 

Cllt >)(cl( 

COJl~J >)(c[ 

Co ii ~J r <•ti J <~ >l(c"J 
P<1~h~ >J(cU 

Select Screen HR 

Copy Copy the selected screen area to the clipboard. 

Copy Table Copy the selected screen area to the clipboard preserving 
columnar formats. (Converts two or more SPACEs to a 
TAB.) 

Paste Copy the entire contents of the clipboard to the screen. 
(Sends characters to the host as fast as a fast typist would 
type them.) 

Select Select the entire screen for later printing or saving to the 

screen Workstation log file. (See the Log F ii e and Log 
Selection to ... selections under the File menu.) 
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Settings Menu 
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The Settings menu lets you modify the way your current invocation of 
MMF Workstation runs. 

Session ... 

Host ... 

Keyboard ... 

Reset Session 

Session ... 
Host ... 

Keybonrd ... 

Reset Session 

Go to the Session Settings dialog box to set various 
LU Session-related parameters. 

Go to the Host Settings dialog box to set host-related 
information. (For use with MMF Workstation file 
transfer operations.) 

Go to the Keyboard Settings dialog box to modify the 
assignment of 3270 functions to keys on your 
keyboard. 

Reset the LU session connection with the host. (For 
use in case of connection difficulties.) 

Menus 



Session ..• 

Menus 

The Session ... selection in the Settings pull-down menu gives you the 
Session Settings dialog box: 

K CUT --{ 

Session Settings 

Screen size I Model 2 - 24H80 

Logical Unit CI:] 
181 Use eHtended attributes 

Screen font size [JI] Print font size C!:J 
Print font ._I _R._r._m_o._'llk ____ _ 

Cursor style O Underline ® Block 

D Use Host Cursor 181 Blinking 

Background ® I Vhlt• I 0 ------IY•Tiowl 
( Defttult Colors ) 

1•-·a·K-!ll!lllll\)J Cancel 

For complete information on how to use the Session Settings dialog box, 
see Chapters 4 and 5. 
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Host .•• 
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The Host ••• selection lets you give information about the IBM host 
machine for a file transfer; it's not necessary for regular 3270 window use. 

The Host Settings dialog box looks like this: 

IBM Host Type 0 CICS 0 UM/CMS 0 TSO 

IBM Host File Tronsfer ® nntor O I BM 

HFT Progrom Nome ... II _________ ..... 

OK D ( Concel ) 

For information on filling out the Host Settings box, see Chapters 6 and 7. 
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Keyboard ... 

Keyboard ... gives you a dialog box that lets you rearrange the 
assignments of 3270 functions on your Macintosh keyboard. 

To get a printout of all five possible arrangements (keys, CONTROL-keys, 
SIIlFf-keys, etc,) click on the Print button. The printout goes to the 
printer that's currently selected in your Chooser. 

!'rt l'P7 l:ltn1 1'11ht 
PF2 PF• 
PFI PF9 PF1S 
PF4 PF1D PF16 PF22 1111-lot 81.nQ ~vl:NI rH PAI T•~ 
1"'9 l"F11 l"fll 1"1'25 Mt1 Clrr I>"!_ ""'"" 1"112 i.m ,,, Pnz ,,,. 

c:naaH • IUDCUDR klU from peletlB 

~ -1 ..... I --1-1--11 I I I 11 I I I 11 I I I 

ITIJ 1-c'"-+-•+-I 1-•-1 ITIJ.,.,. 
4 s ' .. 

c c ....... , I 

For complete information on using the Keyboard Settings dialog box, see 
Chapter?. 

Function Keys Menu 

Menus 

This menu is a tear-off palette. To tear it off, drag the mouse all the way 
through the palette before you release. The palette will float free and you 
can then move it around by grabbing the title bar with the mouse. 

You can type keys with the palette - click on the keys with the mouse. 

You can also reassemble the palette with your own of frequently-used keys. 
You can then keep your new palette handy on your screen - it's a floating 
window and always stays in front. To create your palette, use X-mouse to 
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move the desired keys to one corner, then OPTION-mouse to size the 
window down around them. 

For complete information on how to use the Function keys palette, see 
Chapter 5. 

Windows Menu 

)( CUT This feature is not available on MMF CUT Workstations. 

A-196 

The windows menu lets you manage the windows that MMF Workstation is 
using. 

Remember, to go to other windows in other applications while you're 
running MMF Workstation, you must be running the MultiFinder. 

Hide Session XH 
Jump Session XJ 
Stack Windows 
Tile Windows 

Untitled: I X1 

Menus 



Hide Session ... 

Jump Session 

Stack Windows 

Tile Windows 

Untitled: 1 Kl 

Untitled:2 X2 

Untitled:2 X3 

etc. 

Menus 

Remove a current LU session from view (but do not 
terminate it). 

Example: we had two sessions; we hid Untitled: 1. 
Untitled: 1 now shows up in the menu with a triangle 
beside it to indicate that it is a hidden window: 

t:. Untitled: 1 X 1 
Untitled:2 X2 

-

To retrieve Untitled: I, we select it here with the mouse 
or press Kl. 

Go to the next session's window (Takes current sessions 
in the order of their numbers in their title bars.) 

Rearrange all the session windows into a neat 
overlapping stack of same-sized windows. 

Rearrange all the session windows into a side-by-side 
display of same-sized windows. 

(These are window titles, which are based on the names 
of Session Settings documents. To go to a window, 
click on the title with the mouse or press X 1 , X 2, 
etc.) 
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Easy Keys Menu 

A-198 

The Easy Keys menu lets you record a series of keystrokes, assign them to a 
single 3€-key combination, and then play them back later. 

For complete information on creating and using Easy Keys, see Chapter 5. 

Easy Keys 
Start Recording 
Edit ... EasyKeys 

Stop Recording 
HHL,, 

Start Recording 

Stop Recording 

Edit ... 

(Defined Easy 
Keys) 

EasyKeys 
Start Recording 
Edit ... 

New EasyKey 

You can now type the sequence of keys you want to 
become an Easy Key. 

Tells MMF Workstation to stop recording keys for 
the Easy Key. 

Lets you edit an EasyKey's keystrokes 

Select one of these to cause MMF Workstation to 
execute the EasyKey. 

Menus 



Appendix B 

Key to MMF Workstation's Icons 
This appendix lists the icons you may see when you use MMF Workstation. 

System Icons 
Icon Type Does this: 

Control Panel Lets you select driver software 
-·- document that MMF products must use; 

El El Ii!] lets you supply configuration 

Avatar parameters to the drivers. 

Application Lets you verify your hardware 
-·- and software installation of 

C«<3 MMF Workstation, and lets 

MacMainFrame Checker 
you configure your MMF 
Workstation. 
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System Icons, continued 

Icon Type Does this: 

Driver for Token- Driver software Lets MMF products communicate 
Ring Workstations: with hardware and perform other 

basic tasks. 

-·-
[[!H:t 

MMFTR 

Driver for SDLC 
Workstations: 

-·-
CG~ 

MMFSDLC 
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System Icons, continued 

Icon 

Drivers for Coax 
Workstations: 

Drivers for 
MMF CUT 
Workstations 

-·-
SE·l!J 

MacSECUT 

-·-
s~o [!] 

SE/30 CUT 

-·-
II· El 

Mac II CUT 

-·-
DX·EI 

DX CUT 

Drivers for 
MMF DFT 
Workstations 

-·-
SE·Q'.!] 

Mac SE DFT 

-·-
s~o!G 

SE/30 DFT 

-·-
II·Q'.!] 

Mac II DFT 

MMF Workstation Icons 

Type 

Driver software 

Does this: 

Lets MMF products communicate 
with hardware and perform other 
basic tasks. 

NOTE: The DX CUT driver is for 
use on all Macintosh hardware 
platforms. 
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Application Icons 

B-202 

Icon 
For Token-Ring 

and SDLC 
Workstations: 

For Coax DFT 
Workstations: 

For Coax CUT 
Workstations: 

CEICUT 

MacMainFrame 
Workstation 

Application 

Name and Function: 

MacMainFrame Workstation -
This is the MMF Workstation 
software. Accepts and displays 
data in your 3270 windows; 
communicates with the MMF 
Workstation driver. 

MMF Workstation Icons 



Application Icons, continued 

Icon Type Name and Function: 

For Token-Ring Session Settings Saves your MMF Workstation 
and SDLC documents set-up - terminal class( es), LU 

Workstations: sessions, host configuration, 

~ 
keyboard layout, etc. 

. 
For Coax DFT 
Workstations: 

w . 
For Coax CUT 
Workstations: 

fa . 
(User supplies 

name) 

[tJ 
Batch document Contains commands for MMF 

Workstation to perform batch 
processing of uploads, downloads, 

(User supplies 
and File deletes. 

name) 
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Application Icons, continued 

Icon T__yp_e Name and Function: 

Application MacMainFrame 3287 - Emulates a 
- . - 3287-type printer and lets MMF 
~3287 Workstation route an IBM print 

MacMainFrame stream to the Chooser printer. 

3287 

m Font Armonk-Avatar's proprietary type 
font (bitmap version), for use with 

Armonk 
MMF Series products. 

D Font Armon - Postscript version of 
Armonk font. 

Armon 

[ID Print Settings document Saves your MMF 3287 set-up. 

. 
(User supplies 

name) 
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Appendix C 

The Tab Stops Dialog Box 

Introduction 

Items 

Ruler 

This appendix describes the Tab Stops dialog box. 

To invoke the Tab Stops box, click the EH pan d Tabs check box in the 
Upload/Download box. 

Use the Tab Stops box to reset the tab stops in the destination file when 
you're doing a file transfer with MMF Ff. 

Choose tob stops for eHponslon during uplood: 

10 20 30 40 50 60 70 so 
••• • 1.,,, 1,,,,,,,,, 1,,,, 1,,,, J,,,, 1 ••• • 1 •••• 1,,,, J,.,,,,,,, 1,,, .1,,,, 1 ••• , 1 •••• 1 • • • • • • • • • • 
K OK D ( Re11ert ) Clear Tabs Standard Tabs 

Use the ruler to set the tab stops by clicking the TAB markers to where you 
want them. These will be the TAB stops in the destination file. 
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( Standard Tabs ) 

Click Stondord Yobs to set the TABs in the destination file to the 
standard TAB increments. Standard TAB stops are every 8 spaces. 

( Clear Tabs ) 

Click Clear Yobs to clear all TAB stops. MMF then converts each TAB 
character to one space. 

( Reuert ) 

C-206 

Click Reuert to revert the TAB setup to its layout before you invoked this 
box. 

Tab Stops Dialog Box 



Glossary 
ASCII American Standard Code for Information Interchange. Standard 
ASCII code uses seven bits to identify a single character. 

Binary Format A way of transferring files to and from Macintosh 
machines. In binary format, only the data part of the Macintosh file is 
transferred. 

Block size Under TSO, this is the number of bytes per block of the host 
file. 

CICS Customer Information Control System, an operating environment 
found on IBM host machines. 

Class, LU Session See LU Session Class. 

CMS Conversational Monitor System, an operating environment found on 
IBM host machines. 

Default An option that's already selected (or typed in) when a dialog box 
appears. The option remains in effect unless you change it. 

Document format A way of transferring files to and from Macintosh 
machines. In document format, all three parts of the Macintosh file as well 
as other information are transferred. 

Download To transfer a file from an IBM mainframe (host) machine to an 
outlying computer. 

EBCDIC Extended Binary Coded Decimal Interchange Code. IBM's 
character set, for use in information transfer among IBM machines. 
EBCDIC code uses eight bits to identify a single character. 

File transfer Moving a file from one computer to another. With 
MMF/GW Client, the file can be uploaded (transferred from the Macintosh 
to the IBM host) or downloaded (transferred from the IBM host to the 
Macintosh). 

HFT Avatar's Host File Transfer software for IBM mainframes. Runs on 
the IBM host machine. 
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Host An IBM mainframe computer. Specifically, the IBM machine with 
which MMF/GW Client communicates. 

IND$FILE IBM's file transfer software for IBM mainframes. Runs on 
the IBM host machine. 

LAN Local-Area Network. 

Log off (host) To end communication with the IBM mainframe (host) 
machine. 

Log on (to host) To establish communication with the IBM mainframe 
(host) machine. 

LU Logical unit; generally refers to an outlying software entity that 
communicates with an IBM machine over an IBM network. 

LU Session An ongoing computer-network communication between an 
IBM host computer and an outlying machine. 

MacBinary format The style of Document transfer format that MMF/GW 
Client uses to transfer files. See also Document format. 

Overwrite (file) To replace the data of an existing file with new data, 
discarding all the previous data. 

Print Settings document A Macintosh document that describes the 
settings a user uses in MMF 3287. A MMF 3287 user can have several 
Print Settings documents. 

Session Settings document A Macintosh document that describes the 
settings a user uses in MMF/GW Client - the LU class, color preferences, 
and so on. A Client user can have several Session Settings documents. 

Status line The line at the bottom line of the 3270 screen that displays 
status messages for the user. 

Terminal emulation Simulating the screen appearance and keyboard 
action of one terminal on another. MMF/GW Client emulates IBM 3270-
style terminals on Macintosh machines. 

Terminal window A MMF/GW Client Macintosh window that contains a 
3270-style terminal screen. 
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Glossary 

Text format A way of transferring files to and from an IBM mainframe 
(host) machine. In text format, only the data part of the Macintosh file is 
transferred and all characters are translated from ASCII (native format on 
the Macintosh) to EBCDIC (native format on IBM host machines) or vice 
versa depending on the direction of the transfer. 

TSO Time Sharing Operating System, an operating environment found on 
IBM host machines. 

Upload To send a file from an outlying computer in to an IBM mainframe 
(host) machine. 

G-209 



G-210 Glossary 



X-1 through -8 (Switching Sessions) 50 
X-click (Light pen feature) 101 
X-key combinations 

Default 81 
For Easy Keys 95, 98 

3270 Functions 84 
Assigning to keys 85 
clicking keys with mouse 89 
Removing from keys 87 

3270keys 78 
3270 window 32, 55, 75 

Changing characteristics 61 
Closing 56 
Light pen 101 
LU indicator 57 
Maximum number of 55, 62 
Pasting to 73 
selecting data from (See also Selecting data) 
Stacking 63 
Tiling 63 
Using 58 

3287 printers 167 
3287 Setup box 176 

Items 177 
3287 Setup button 175 

A 

Administrator, network 19, 31 
API (Application Program Interface) 11 
Append CR to each line (Upload/Download box) 121 
Append to Host file(Upload/Download box) 121 
Apple Menu 

Get Info 40 
Application 

Start-up from 16 
Armon 

Icon 206 

Index 
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Armonk™ font 171 
Icon 206 

ASCII 106 
Attributes (Session Settings box) 31 
Attributes, extended 31, 47 
Avatar 

B 

Control Panel document 
Icon 201 

HFT 
Deleting files on CICS host 138 
Viewing files on CICS host 136 

Background (Session Settings box) 34 
Background/Foreground processing (File Transfer) 111 
BACKSPACE 125 
BACKTAB Key 59 
Basic operations 45 
Batch button (CICS Delete box) 138, 163 
Batch button (Upload/Download box) 131, 163 
Batch file 161, 162 

Icon 205 
Batch File ... (File menu) 162 
Batch Transfer ... (File menu) 164 
Binary format (File Transfer) 108 
Black and white boxes (Session Settings box) 35 
Blinking (Extended attribute) 47 
Block Size (Upload/Download box) 121 
Boxes (See also: Dialog boxes, Information boxes) 
Buffer, Extended attribute 47 
Buttons 

c 

3287 Setup 175 
Keyboard Help 57, 78 

Cancel button (EasyKeys box) 98, 100 
Cancel button (Keyboard Settings box) 86 
Cancel button (Upload/Download button) 131 
Carriage Return (CR) 121 
Characters 



Attributes (EABs) 47 
Converting unprintable 107 
Inserting special 124 

Checker 
Icon 201 

Choose button (CICS Directory box) 136 
Chooser 

Printer 167 
CICS 135 

Deleting files on host 13 8 
Viewing files on host 136 

CICS Filename (Upload/Download box) 121 
Clicking keys with mouse 89 
Clipboard 

Macintosh 71 
Close (File Menu) 39, 42, 53 
CMS file mode 123 
CMS file type 124 
CMS Filename (Upload/Download box) 121 
CMSHFT 116 
Colors 34 

Changing 36 
Color wheel 35, 36 
Default 35 
Extended attribute 47 
Highlight34 
IBM35 
Screen background 34 

CONTROL Key 77 
Converting unprintable characters 107 
Copy (Edit Menu) 72, 73 
Copy Table (Edit Menu) 72, 73 
Copying data from 3270 window 71 
CR (carriage return) characters 68, 72 
CR is record separator (Upload/Download box) 122 
Cursor 

Lighted (Light pen feature) 101 
Positioning 59, 101 

By keyboard 59 
Bymouse59 
Like a light pen 59 

Using as light pen 101 
CURSOR SELECT key 59 
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Cursor Style (Session Settings box) 32 
Customizing Function Keys 

Menu91 

D 

Data (Macintosh files) 105 
Default Binary 110 
Default colors (Session Settings box) 35 
Defaults 

Keyboard88 
Delete Host File ... (File menu) 138 
Deleting files on the CICS host 138 
Destination (3287 Setup box) 177 
Dialog Boxes 

3287 Setup 176 
Items 177 

Keyboard84 
Personalize 17 
Print 179 
Session Settings 19, 29 
Tab Stops 209 
Upload/Download 120 

Directory button (CICS Delete box) 138 
Directory button (Upload/Download box) 122, 136 
Disk button (3287 Setup box) 183 
Disk files 

Sending print streams to 177, 183 
Document format (File Transfer) 110, 141, 144, 148, 151, 156, 159 
Documents 

Session Settings 24, 39, 170 
Download (File Menu) 46, 117 

Dialog box 120 
Downloads 

Binary format (File Transfer) 
From CICS 143 
From TSO 158 
From VM/CMS 150 

Document format 
From CICS 144 
From TSO 159 
From VM/CMS 151 



Status window 132 
Text format 

From CICS 141 
From TSO 157 
From VM/CMS 149 

Dragging 
To System Folder 170 

Drivers 
Icons 202, 203 

E 

EABs 31, 35, 47 
EasyKeys 95 

Dialog box 97 
Editing 100 
How to play back 99 
How to record 95 

EBCDIC 106 
Edit Menu 71 

Select Screen 67 
Edit ... 

EasyKeys Menu 100 
End of Line (3287 Setup box) 177 
Everyday start-up 24 
Excel™ WKS 110 
Execute button (Upload/Download box) 130 
Expand Tabs (Upload/Download box) 122, 209 
Extended attributes (EABs) 34, 47 

F 

Fields 
Input 73 

File box 118 
For downloads 119 
For screen log file 69 
For uploads 118 

File menu 68 
MMF Workstation 19 

File mode (Upload/Download box) 123 
File Transfer 46, 103 
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Background/foreground processing 111 
HFT 104 
Host-resident file transfer software (HFT) 104 
How to transfer a file 113 
MacBinary format 110 
Multiple LU Sessions 111 
Status window 132 
To/from CICS 135 
Transfer formats 105, 118 

Binary format 108 
Document format 110 
MacBinary format 110 
Text format 105 

Troubleshooting 133 
File Transfer Status window 132 
File type (Upload/Download box) 124 
Files 

Batch 161, 162 
Deleting on CICS host 138 
Disk 

Sending print streams to 177, 183 
Macintosh 105 

Preserving filename on host 111, 129 
MacWrite 108 
Padding and fragmenting 107, 108 
Text-only 106, 108 
Types 109 

Macintosh 109 
Viewing on CICS host 136 

Finder 18, 25, 40, 174 
First-time start-up 16, 52 
Font (3287 Setup box) 178 
Font /DA Mover 32 
Font Size (3287 Setup box) 178 
Font/DA Mover 171, 178 
Fonts 

Armonk 171 
Font size palette (3270 Window) 57 
For MMF 3287 182 
Print 32 
Screen 

Sizes 32 
Sizes 



Preserving 67 
FORM FEED 125 
Format 

Text, Binary, Document (Upload/Download box) 124 
Function Keys 

G 

Menu89 
Customizing 91 
Tearing off 90 

Palettes 
Moving94 
Rearranging 92 
Sizing 93 

General CAD-CAM binary 110 
Get Info (Apple Menu) 40 
Glossary 213 
Graphics, MacMainFrame 10 

H 

Header (Macintosh files) 105 
Help 

Keyboard 57, 78 
HFT 116 

Avatar 136, 138 
HFT Program Name (Host... selection in Settings menu) 116 
Hide Windows (Windows menu) 65 
Hiding windows 65 
Highlight color 34 
Host AID Keys 96 
Host-resident file transfer software See also HFf 
Host... (Settings Menu) 46, 53, 115 
How to change Session Settings 52 
How to edit Easy Keys 100 
How to end LU Sessions 51 
How to get an LU Session 48 
How to install the Armonk font 171 
How to play back an EasyKey 99 
How to record an Easy Key 95 
How to transfer a file 113 

I-217 



I-218 

How to type 3270 keys 82 
How to view your keyboard set-up 78 

IBM 3270 Keys 57 
IBM colors 35 

Changing36 
Default 35 

IBMHost27 
And MMF 3287 shut-down 185 
As file server 110 
CICS 135 
Cursor 33 
Environment 104 
Establishing connection to 20, 27 
File transfers to/from 46 
Logging off 38 
Logging on/logging off 51, 53 
Print stream from 167 
Settings 115 

IBM Host File Transfer (Host ... selection in Settings menu) 115 
IBM Host Type (Host... selection in Settings menu) 115 
IBM Keys 

CURSOR SELECT 59 
IBM Terminals 55, 76 
Icons 201 

Application 16 
MMF3287173 
Session Settings document 24 

IND$116 
IND$FILE 116 
Information boxes 

File Transfer 
Status window 132 

Personalize 25 
Print Status window (MMF 3287) 181 

Initial host screen 20, 27 
Input fields 73 
Insert special characters (Upload/Download box) 124 
Interpret SCS Commands (3287 Setup box) 177 



J 

Job Timeout (3287 Setup box) 177 
Jump Session (Windows Menu) 50, 66, 197 

K 

Keyboard 75 
Basic 76 
Changing your layout 83 
Defaults 88 
Dialog box 84 
How to view your set-up 78 
Menus76 
Printout of 80, 86 
Re-mapping 83 
Removing 3270 functions 87 
Support for Macintosh 77 
Testing your layout 88 
Undoing your layout 86 

Keyboard Help Button 57, 78 
Keyboard ... (Settings Menu) 53, 80, 83 
Keys 

L 

Assigning 3270 functions to 85 
Grayed 82 
HostAID96 
How to type 82 
Typing on the keyboard 82 
Typing on the screen 82 

Light pen 101 
Positioning cursor as 59 

Lock box (Save As ... box) 40 
Log file 

Screen 69 
Log File (File menu) 69 
Log Selection to ... (File Menu) 68 
Logical Unit (Session Settings box) 30, 31 
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Logical Units (LUs) 182 
LU Indicator (3270 Window) 57 
LU Sessions 9, 12, 31, 47 

Changing 
From Terminal to Printer to Graphics 169, 184 

Changing colors 36 
Colors 35 
Ending 51 
Ending a single 51 
For MMF 3287 182 
For printers 167 
Getting your first 19, 25, 48 
How to get48 
How to view 47 
Jump Session (Windows menu) 66 
Maximum per Client 50 
New (ForMMF 3287) 184 
Releasing 38, 42, 43 
Session Settings box 29 
Starting 48, 49 
Switching 49 
To get additional sessions 50 
Using multiple LU Sessions for File Transfer 111 

LUs (Logical units) 31 

M 

MacBinary format (File Transfer) 110 
Macintosh 

Clipboard 71 
Files 105 
Filetype 109 
Keyboard support 77 
Keyboards 

CONTROL Key on small 77 
Menu bar 18, 25, 174 
Monitors 32 

Color 34 
MultiFinder 46 
Windows 

Using other 46 
Macintosh Filename (Upload/Download box) 125 



Macintosh Filetype (Upload/Download box) 126 
Macintosh-to-Macintosh document exchanges 110 
MacMainFrame (See also MMF) 
MacMainFrame Graphics 10 
MacWrite 106, 108 
Member name (Upload/Download box) 126 
Menu bar 

Macintosh 18, 25, 174 
MMF3287174 
MMF Workstation 18, 25 

Menus 
Function Keys 89 
Keyboard 76 
MMF Workstation 

File 19 
Pop-up 30 
Settings 80 

Host... 115 
Tear-off 90, 92 
Windows47 

Microsoft® Word 3.0 110 
MMF3287167 

How to disable from printing 180 
How to enable to print 179 
Icon 206 
Menu bar 174 
Print Status window 181 
Shut-down 185 

MMF Workstation 
Basic operations 45 
Files 170 
Icon 204 
Icons 201 
Introduction 1 
Keyboard 75 
Menu bar 18, 25 
Session Settings box 29 
Shut-Down 38 
Start-up 13, 16, 24 

MMF/GW Client 12 
Monitors 

Color 34 
Macintosh 32 
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Mouse 
Clicking keys with 89 
Using as light pen 101 

MS-DOS 108 
MultiFinder 46 

N 

Networks 
Administrator 31 

New (File Menu) 19. 48, 88 
NEW LINE (Line Feed) 125 
New Session ... (File Menu) 48, 49 
Number of Records (Upload/Download box) 126 

0 

Open (File Menu) 48, 53 
Operating 

Basic operations 45 
Overwrite Existing File (Upload/Download box) 126 

p 

Padding and fragmenting files (File Transfer) 107, 108 
PageMaker™ 2.0 & 3.0 110 
Pages per Job (3287 Setup box) 177 
Palettes 

Font size (3270 Window) 57 
Function Keys 

Moving94 
Rearranging 92 
Sizing 93 

Paste (Edit Menu) 73 
Pasting data to windows 73 
Personalize box 17 
Pop-up menus 

Session Settings box 30 
Positioning the cursor 59. 101 
Print (File menu, MMF 3287) 179 
Print button (Keyboard Settings box) 80, 86 



Print font (Session Settings box) 30, 32 
Print font size (Session Settings box) 30, 32 
Print parameters (See Print Settings) 
Print Settings 

How to change 17 5 
Print Settings documents (MMF 3287) 

Icon 17 6, 206 
New 174 

Print Status window 181 
Printers 178 

3287 167 
Printing (MMF 3287) 

Current line 182 
Current page 182 
Dialog box 179 
End of line 182 
How to disable MMF 3287 180 
How to enable MMF 3287 179 
How to stop MMF 3287 185 
Job timeout 182 
Line spacing 182 
Pages per job 182 
SCS commands 182 
Status window (MMF 3287) 17 4 
Wrapping print lines 178 

Protection, character 47 

Q 

Question Mark (Keyboard Help Button) 78 
Quit (File Menu) 39, 43 

R 

Re-mapping your keyboard 83 
Record Format (Upload/Download box) 127 
Record separator character 122 
Record Size (Upload/Download box) 127 
Records (File Transfer) 126 
Refresh button (CICS Directory box) 137 
Remove button (EasyKeys box) 98 
Remove Session ... (File Menu) 42, 51 
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Resources (Macintosh files) 105 
RETURN 125 
Reverse video (Extended attribute) 47 
Revert button (EasyKeys box) 98, 100 
Revert button (Keyboard Settings box) 86 
Revert button (Tab Stops box) 210 
RRR3116 

s 
Save (File Menu) 39, 53 
Save As ... (File Menu) 39, 43, 53 
Save As ... button (Upload/Download box) 127 
Save Selection As ... (File Menu) 68 
Save terminal file as 127 

In Download File box 119 
Saving Your Settings 23, 37, 39, 53 
Screen 

Background color 34 
Initial host 20, 27 

Screen font size (Session Settings box) 30, 32 
Screen fonts 32 
Screen log file 69 
Screen size (Session Settings box) 30, 31 
SCS (SNA character stream) commands 177 
Select button (Upload/Download box) 125, 128 
Select Screen (Edit Menu) 67 
Selecting data from 3270 window 67 

Copying and pasting 71, 73 
Entire window 67 
Logging to a file 68 
Small area 67 

Session Settings 
Dialog box 19, 29, 49, 52 

Items 31 
Documents 170 
How to change 52 

Open Session Settings Document 52 
Unopened Session Settings Document 53 

Recording 19 
Saving 37 

Session Settings box 30 



Session Settings document 39, 41 
Contents 41 
For default keyboard settings 88 
Icon 205 
Locking/Unlocking 40 
Opening 48, 53 
Start-up from 24 

Session ... (Settings Menu) 52 
Settings Menu 

Host ... 115 
Keyboard ... 83 

Shut-down 13, 23, 28, 38 
MMF3287185 

SNA character stream commands (SCS) 177 
Software 

Shut-Down 38 
Spacing (3287 Setup box) 178 
Special characters 

Inserting 124 
Spreadsheets 

Copying data to 72 
Stack Windows 63,.197 
Stack Windows (Windows menu) 63 
Start Recording (EasyKeys Menu) 95 
Start-up 13 

everyday 24 
First-time 16, 52 

Statistics (Load Status box) 133 
Status 

Upload/Download 132 
Status line (3270 Window) 57 
Stop Recording (EasyKeys Menu) 96 
System Folder 172 

Dragging icons to 170 

T 

TABKey59 
Tab Stops box 209 
TABs 125 

Converting 68, 72, 107 
Expanding 122 
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Standard 210 
Tab Stops box 209 

TeachText 106 
Tearing off Function Keys menu 92 
Tenninals 

3270-style screens 58 
CUT (Control Unit Terminals) 4 
DFT (Distributed Function Terminals) 4 
IBM 55, 76 
LU Sessions for 47 

Terminology 1 
Text format (File Transfer) 105, 139, 141, 146, 149, 154, 157 
Tile Windows 64, 197 
Tile Windows (Windows menu) 63 
Title bar 

3270 Window 56 
Trailing spaces 

Removing 108 
Transfer formats 105, 118, 124, 129, 133 
Troubleshooting (File Transfer) 133 
TSO Allocation (Upload/Download box) 128 
TSO data set 

partitioned 126 
TSO File Name(Upload/Download box) 129 
TSOHFT 116 
Typing keys on the screen 89 

u 
Underlining (Extended attribute) 47 
Upload (File Menu) 46, 117 

Dialog box 120 
Uploads 

Binary format (File Transfer) 
ToCICS 140 
To TSO 155 
To VM/CMS 147 

Document format 
To CICS 141 
To TSO 156 
To VM/CMS 148 

Status window 132 



Text format 
To CICS 139 
To TSO 154 
To VM/CMS 146 

Use extended attributes (Session Settings box) 31 
Use name from host file image (Upload/Download box) 129 
Using other Macintosh windows 46 

v 

VAX™NMS 110 
VERTICAL TAB 125 
Viewing files on the CICS host 136 

W, X, Y, Z 

Whitespace 
Converting 68, 72 

Windows 
3270 32, 55 

Maximum number of 62 
Closing 38, 51 
File Transfer Status 132 
Function Key palette 91 

Saving 94 
Hiding65 
Jump Session 66 
Keyboard53 
Pasting to 73 
Stacking 63, 197 
Switching LU Sessions 49 
Tiling 63, 64, 197 
Using other Macintosh 46 

Windows Menu 47, 48, 50 
Workstation 

Sessions per user 50 
Wrapping 

Print lines 178 

I-227 







65-2500-100-AA 

AVATAR CORPORATION 

65 South Street, Hopkinton, MA 01748 

© 1990 Avatar Corporation. 


